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safety information
These warnings and precautions are included in order to prevent injury to you and others, as well as preventing any 
potential damage to your machine. Be sure to read and understand all of these instructions before using the machine.
Use common sense for operating any electrical appliance and whenever using your machine. Also, follow all warnings and 
instructions marked on the machine and in the accompanying literature. After reading this section, keep it in a safe place 
for future reference.

IMPORTANT SAFETY SYMBOLS

This section explains the meanings of all icons and signs in the user's guide. These safety symbols are in order, according to the degree of 
danger.

Explanation of all icons and signs used in the user’s guide:

OPERATING ENVIRONMENT

 Warning

Warning Hazards or unsafe practices that may result in severe personal injury or death.

Caution Hazards or unsafe practices that may result in minor personal injury or property damage.

Do not attempt.

Do not disassemble.

Do not touch.

Unplug the power cord from the wall socket.

Make sure the machine is grounded to prevent electric shock.

Call the service center for help.

Follow directions explicitly.

Do not use if the power cord is damaged or if the 
electrical outlet is not grounded.
► This could result in electric shock or fire. 

Do not bend, or place heavy objects on the power 
cord. 
► Stepping on or allowing the power cord to be 
crushed by a heavy object could result in electric 
shock or fire. 

Do not place anything on top of the machine (water, 
small metal or heavy objects, candles, lit cigarettes, 
etc.).
► This could result in electric shock or fire. 

Do not remove the plug by pulling on the cord; do not 
handle the plug with wet hands. 
► This could result in electric shock or fire. 
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 Caution

OPERATING METHOD

 Caution

If the machine gets overheated, it releases smoke, 
makes strange noises, or generates an odd odor, 
immediately turn off the power switch and unplug the 
machine.
► This could result in electric shock or fire. 

During an electrical storm or for a period of 
non-operation, remove the power plug from the 
electrical outlet. 
► This could result in electric shock or fire. 

If the plug does not easily enter the electrical outlet, do not 
attempt to force it in. 
► Call an electrician to change the electrical outlet, or this 
could result in electric shock.

Be careful, the paper output area is hot. 
► Burns could occur. 

Do not allow pets to chew on the AC power, telephone or PC 
interface cords.
► This could result in electric shock or fire. 

If the machine has been dropped, or if the cabinet appears 
damaged, unplug the machine from all interface connections 
and request assistance from qualified service personnel.
► Otherwise, this could result in electric shock or fire.

If the machine does not operate properly after these 
instructions have been followed, unplug the machine from all 
interface connections and request assistance from qualified 

service personnel.
► Otherwise, this could result in electric shock or fire.

If the machine exhibits a sudden and distinct change in 
performance, unplug the machine from all interface 
connections and request assistance from qualified service 

personnel.
► Otherwise, this could result in electric shock or fire.

Do not forcefully pull the paper out during printing.  
► It can cause damage to the machine.

When printing large quantities, the bottom part of the 
paper output area may get hot. Do not allow children 
to touch. 
► Children may be burned.

Be careful not to put your hand between the machine 
and paper tray.
► You may get injured.

When removing jammed paper, do not use tweezers 
or sharp metal objects. 
► It can cause damage to the machine.

Do not block or push objects into the ventilation opening.
► This could result in elevated component temperatures which 
can cause damage or fire.

Do not allow too many papers to stack up in the paper output 
tray.
► It could cause damage to the machine. 

Use care to avoid paper cuts when replacing paper or removing 
jammed paper. 
► You may get hurt.

This machine's power interception device is the power cord. 
► To switch off the power supply, remove the power cord from 
the electrical outlet. 
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INSTALLATION / MOVING

 Warning

 Caution

MAINTENANCE / CHECKING

 Caution

Do not place the machine in an area with dust, 
humidity or water leaks. 
► This could result in electric shock or fire. 

When moving the machine, turn the power off and 
disconnect all cords; then lift the machine with at 
least two people.
► The machine could fall, causing human injury or 
machine damage.

Do not put a cover over the machine or place it in an airtight 
location, such as a closet.
► If the machine is not well-ventilated, this could result in fire.

Do not place the machine on an unstable surface.
► The machine could fall, causing human injury or machine 
damage.

Make sure you plug the power cord into a grounded electrical 
outlet.
► Otherwise, this could result in electric shock or fire.

The machine should be connected to 
the power level which is specified on the label.
► If you are unsure and want to check the power level you are 
using, contact the electrical utility company.

Do not overload wall outlets and extension cords.
► This can diminish performance, and could result in electric 
shock or fire.

Use only No.26 AWGa or larger, telephone line cord, if 
necessary.
► Otherwise, it can cause damage to the machine.

a.  AWG: American Wire Gauge

Use the power cord supplied with your machine  for safe 
operation. If you are using a cord which is longer than 2 meters 
(79”) with a 140V machine, then the gauge should be 16 AWG 

or larger.
►  Otherwise, it can cause damage to the machine, and could 
result in electric shock or fire.

Unplug this product from the wall outlet before 
cleaning the inside of the machine. Do not clean the 
machine with benzene, paint thinner or achol; do not 
spray water directly into the machine. 
► This could result in electric shock or fire. 

Keep cleaning supplies away from children. 
► Children may get hurt.

When you are working inside the machine replacing 
supplies or cleaning the inside, do not operate the 
machine.
► You may get injured.

Do not disassemble, repair or rebuild the machine by 
yourself. 
► It can cause damage to the machine. Call a 
certified technician when the machine needs repair.
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SUPPLY USAGE

 Caution

Keep the power cable and the contact surface of the plug clean 
from dust or water.
► This could result in electric shock or fire. 

To clean and operate the machine, strictly  follow the user's 
guide provided with the machine.
► Otherwise, it can cause damage to the machine.

Do not remove any covers or guards that are fastened with 
screws. 
► The machine should only be repaired by Samsung service 
technician.

Do not disassemble the toner cartridge.
► Toner dust can be dangerous to humans.

When storing supplies such as toner cartridges, keep 
them away from children..
► Toner dust can be dangerous to humans.

Do not burn any of the supplies such as toner 
cartridge or fuser unit.
► It can cause an explosion or fire.

Using recycled supplies, such as toner, can cause damage to 
the machine.
► In case of  damage due to the use of recycled supplies, a 
service fee will be charged.

When changing the toner cartridge or removing jammed paper, 
be careful not to let toner dust touch your body or clothes.
► Toner dust can be dangerous to humans.
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regulatory information
This machine is designed for our sound environment and certified with several regulatory statements.

LASER SAFETY STATEMENT

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products, and 
elsewhere is certified as a Class I laser product conforming to the requirements of IEC 825.
Class I laser products are not considered to be hazardous. The laser system and printer are designed so there is never any human access to 
laser radiation above a Class I level during normal operation, user maintenance or prescribed service condition.

WARNING 
Never operate or service the printer with the protective cover removed from Laser/Scanner assembly. The reflected beam, although invisible, 
can damage your eyes.
When using this product, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to persons:

OZONE SAFETY

POWER SAVER

During normal operation, this machine produces ozone. The ozone produced does not present a hazard to the operator. However, it is 
advisable that the machine be operated in a well ventilated area.
If you need additional information about ozone, request your nearest Samsung dealer.

This printer contains advanced energy conservation technology that reduces power consumption when it is not in active use.
When the printer does not receive data for an extended period of time, power consumption is automatically lowered. 
ENERGY STAR and the ENERGY STAR mark are registered U.S. marks. 
For more information on the ENERGY STAR program see http://www.energystar.gov

http://www.energystar.gov
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RECYCLING

CORRECT DISPOSAL OF THIS PRODUCT (WASTE ELECTRICAL & ELECTRONIC EQUIPMENT)

(Applicable in the European Union and other European countries with separate collection systems)

RADIO FREQUENCY EMISSIONS

FCC Information to the User
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
• This device may not cause harmful interference, and
• This device must accept any interference received, including interference that may cause undesired operation.
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to 
try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or experienced radio TV technician for help.

 

Change or modifications not expressly approved by the manufacturer responsible for compliance could void the user's authority to 
operate the equipment.

Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference-causing 
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.
Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe B prescrites dans la 
norme sur le matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et Sciences Canada.

Recycle or dispose of the packaging material for this product in an environmentally responsible manner.

This marking on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB
cable) should not be disposed of with other household waste at the end of their working life. To prevent possible harm to the environment or
human health from uncontrolled waste disposal, please separate these items from other types of waste and recycle them responsibly to
promote the sustainable reuse of material resources.
Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and
how they can take these items for environmentally safe recycling.
Business users should contact their supplier and check the terms and conditions of the purchase contract. This product and its electronic
accessories should not be mixed with other commercial wastes for disposal.
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RUSSIA ONLY

AE95AE95

REPLACING THE FITTED PLUG (FOR UK ONLY)

Important
The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and has a 13 amp fuse. When you change or examine the 
fuse, you must re-fit the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, do not use the plug until 
you have another fuse cover. 
The 13 amp plug is the most widely used type in the UK and should be suitable. However, some buildings (mainly old ones) do not have normal 
13 amp plug sockets. You need to buy a suitable plug adaptor. Do not remove the moulded plug.

 

If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you plug it into a socket.

Important warning: 

• Green and Yellow : Earth
• Blue : Neutral
• Brown : Live

If the wires in the mains lead do not match the colors marked in your plug, do the following:
You must connect the green and yellow wire to the pin marked by the letter “E” or by the safety ‘Earth symbol’ or colored green and yellow or 
green.
You must connect the blue wire to the pin which is marked with the letter “N” or colored black.
You must connect the brown wire to the pin which is marked with the letter “L” or colored red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

You must earth this machine.
The wires in the mains lead have the following color code:
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DECLARATION OF CONFORMITY (EUROPEAN COUNTRIES)

Approvals and Certifications

January 1, 1995 : Council Directive 2006/95/EC Approximation of the laws of the member states related to low voltage equipment.
January 1, 1996 : Council Directive 2004/108/EC (92/31/EEC), approximation of the laws of the Member States related to electromagnetic 
compatibility.
March 9, 1999 : Council Directive 1999/5/EC on radio equipment and telecommunications terminal equipment and the mutual recognition of 
their conformity. A full declaration, defining the relevant Directives and referenced standards can be obtained from your Samsung Electronics 
Co., Ltd. representative.

EC Certification
Certification to 1999/5/EC Radio Equipment & Telecommunications Terminal Equipment Directive (FAX)
This Samsung product has been self-certified by Samsung for pan-European single terminal connection to the analogue public switched 
telephone network (PSTN) in accordance with Directive 1999/5/EC. The product has been designed to work with the national PSTNs and 
compatible PBXs of the European countries:
In the event of problems, you should contact the Euro QA Lab of Samsung Electronics Co., Ltd. in the first instance.
The product has been tested against TBR21. To assist in the use and application of terminal equipment which complies with this standard, the 
European Telecommunication Standards Institute (ETSI) has issued an advisory document (EG 201 121) which contains notes and additional 
requirements to ensure network compatibility of TBR21 terminals. The product has been designed against, and is fully compliant with, all of the 
relevant advisory notes contained in this document.

OPENSSL LICENSE

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes 

software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without 

Prior written permission. For written permission, please contact openssl-core@openssl.org.
5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written 

permission of the OpenSSL Project.
6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software developed by the 

OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
This product includes cryptographic software written by Eric Young(eay@cryptsoft.com). This product includes software written by Tim Hudson 
(tjh@cryptsoft.com).

The CE marking applied to this product symbolizes Samsung Electronics Co., Ltd. Declaration of Conformity with the following applicable 
93/68/EEC Directives of the European Union as of the dates indicated:
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ORIGINAL SSLEAY LICENSE

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with 
Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following conditions apply to 
all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this 
distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric Young's, 
and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given 
attribution as the author of the parts of the library used. This can be in the form of a textual message at program startup or in documentation 
(online or textual) provided with the package.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement: "This product includes 

cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library 
being used are not cryptographic related:-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an 
acknowledgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  
IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e. this code cannot simply 
be copied and put under another distribution licence [including the GNU Public Licence.
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EU DECLARATION OF CONFORMITY
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about this user’s guide
This user’s guide provides information about basic understanding of the machine as well as detailed explanation on each 
step during actual usage. Valuable for both novice and professional users can refer to this as a guide for installing and 
using the machine.

 

• Read the safety information before using the machine.
• If you have a problem using the machine, refer to the troubleshooting chapter. (See "Troubleshooting" on page 64.)
• Terms used in this user’s guide are explained in the glossary chapter. (See "Glossary" on page 85.)
• Use Index to find information.
• All illustrations in this user’s guide may differ from your machine depending on its options or models.
• The procedures in this user’s guide are mainly based on Windows XP.

CONVENTION
Some terms in this guide are used interchangeably, as below:
• Document is synonymous with original.
• Paper is synonymous with media, or print media.
• Machine refers to printer or MFP.
The following table offers the conventions of this guide:

 

The date format may differ from country 
to country.

 

Do not touch the green underside of the 
toner cartridge. 

CONVENTION DESCRIPTION EXAMPLE

Bold For texts on the display or button names on the machine. OK

Note Provides additional information or detailed specification of the machine function 
and feature.

Caution Gives users information to protect the machine from possible mechanical 
damage or malfunction.

Footnote Provides additional more detailed information on certain words or a phrase. a. pages per minute

(“Cross-reference”) Guides users to a reference page for the additional detailed information. (See ""Finding more information" on 
page 18".)
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FINDING MORE INFORMATION
You can find information for setting up and using your machine from the following resources, either as a print-out or on screen.

MATERIAL NAME DESCRIPTION

Quick Install Guide This guide provides information on setting up your machine and this requires that you follow the instructions in the guide to prepare the 
machine.

Online User’s Guide This guide provides you with step-by-step instructions for using your machine’s full features, and contains information for maintaining 
your machine, troubleshooting, and installing accessories. 

Network Website You can set the network environment from your computer using network-managing programs, such as SetIP, SyncThru™ Web Admin 
Service, etc.This Website will be convenient for network administrators who need to manage many machines simultaneously. You can 
download the SyncThru™ Web Admin Service on http://solution.samsungprinter.com. SetIp program is provided in the software CD. 

Machine Driver Help This help provides you with help information on printer driver and instructions for setting up the options for printing. (See "Using help" 
on page 44.)

Samsung website If you have Internet access, you can get help, support, machine drivers, manuals, and order information from the Samsung website, 
www.samsungprinter.com.

http://www.samsungprinter.com
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features of your new product
Your new machine is equipped with a number of special features that improve the quality of the documents you print.

SPECIAL FEATURES

Print with excellent quality and speed

Handle many different types of printable material

Create professional documents

Save time and money

Expand your machine’s capacity

* Zoran IPS Emulation compatible with PostScript 3

136 PS3 fonts

• You can print with a resolution of up to 1,200 x 1,200 dpi 
effective output.

• Your machine prints A4-sized paper at up to 28 ppm and 
letter-sized paper at up to 30 ppm.

• For duplex printing, your machine prints A4-sized paper at 
up to 14 ipm and letter-sized paper at up to 14 ipm.

• The multi-purpose tray supports letterhead, envelopes, 
labels, custom-sized media, postcards, and heavy paper. 
The multi-purpose tray holds up to 50 sheets of plain paper.

• The 250-sheet tray 1 and 250-sheet optional tray support 
plain paper in various sizes. 

• Print Watermarks. You can customize your documents with 
words, such as “Confidential”. (See "Using watermarks" on 
page 46.)

• Print Posters. The text and pictures of each page of your 
document are magnified and printed across the sheet of 
paper and can then be taped together to form a poster. (See 
"Printing posters" on page 45.)

• You can use preprinted forms and letterhead with plain 
paper. (See"Using overlay" on page 46.)

• To save paper, you can print multiple pages on one single 
sheet of paper. (See "Printing multiple pages on one sheet of 
paper" on page 44.)

• This machine automatically conserves electricity by 
substantially reducing power consumption when not in use.

• To save paper, you can print on both sides of the paper 
(double-sided printing). (See "Printing on both sides of 
paper" on page 49.)

• This machine has an extra memory slot for adding more 
memory. (See "Available supplies" on page 77.)

• Zoran IPS Emulation* compatible with PostScript 3 (PS) 
enables PS printing.

Print in various environments

©Copyright 1995-2005, Zoran Corporation. All rights reserved. 
Zoran, the Zoran logo, IPS/PS3, and OneImage are trademarks 
of Zoran Corporation.

Contains UFST and MicroType from Monotype Imaging Inc.

• You can print with Windows 2000 and Windows 
XP/2003/Vista as well as Linux and Macintosh systems.

• Your machine is equipped with a USB interface and a 
network interface.
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FEATURES BY MODELS
The machine is designed to support all of your document needs from printing to more advanced networking solutions for your business.
Features by models include:

( ●: Included) 

FEATURES ML-2855ND

Hi-Speed USB 2.0 ●

Network Interface Ethernet 10/100 Base TX wired LAN ●

Duplex (2-sided) printing ●
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1.introduction
This chapter gives you an overview of your machine.
This chapter includes:
• Machine overview
• Control panel overview
•  Understanding the control panel
  

MACHINE OVERVIEW
Front view

 

1
 

7
 

2
 

8
 

3
 

9
 

4
 

10
 

5
 

11
 

6

Output tray Tray 1

Control panel Multi-purpose tray

Control board cover Multi-purpose tray paper extension

Front cover Paper width guides on a multi-purpose tray

Paper level indicator Output support

Optional tray 2a

a.This is an optional feature.
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Rear view
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Power-switch Rear cover

Power receptacle Optional tray 2 cable 
connector

Duplex unit USB port

Tray rear cover Network Port



Introduction_ 23

CONTROL PANEL OVERVIEW

 

1
 

2
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4
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Display Shows the current status and prompts during an operation. 

(Menu) Enters menu mode and scrolls through the available menus.

OK Confirms the selection on the screen. 

Left/right arrow Scroll through the options available in the selected menu, and increase or decrease values. When entering characters, use 
right key to add empty space.

(Back) Sends you back to the upper menu level. 

(Power) Stops an operation at any time and there are more functions. (See "Understanding the control panel" on page 24.)

(Status LED) Shows the status of your machine. (See "Understanding the control panel" on page 24.)
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UNDERSTANDING THE CONTROL PANEL
Status LED

The color of the Status LED indicates the machine's current status.

 

Check the message on the display screen. Follow the instructions in 
the message or refer to troubleshooting part. (See "Understanding 
display messages" on page 67.) If the problem persists, call for 
service.

Buttons

When you want to know the machine status and set your machine to use an 
advanced feature press  (menu button). (See "Accessing the menu" on 
page 53.)

By pressing the  (stop button), you can: 
STATUS DESCRIPTION

Off The machine is off-line.

Green Blinking • When the backlight slowly blinks, the machine 
is receiving data from the computer.

• When the backlight blinks rapidly, the 
machine is printing data. 

On • The machine is on-line and can be used.
• The machine is in power saver mode. When 

data is received, or any button is pressed, it 
switches to on-line automatically.

Red Blinking • A minor error has occurred and the machine is 
waiting for the error to be cleared. Check the 
display message. When the problem is 
cleared, the machine resumes. 

• Small amount of toner is left in the cartridge. 
The estimated cartridge lifea of toner is close. 
Prepare a new cartridge for replacement. You 
may temporarily increase the printing quality 
by redistributing the toner. (See 
"Redistributing toner" on page 64.)

a.Estimated cartridge life means the expected or estimated toner 
cartridge life, which indicates the average capacity of print-outs and is 
designed pursuant to ISO/IEC 19752. (See "General specifications" on 
page 80.) The number of pages may be affected by operating 
environment, printing interval, media type, and media size. Some 
amount of toner may remain in the cartridge even when Toner 
Exhausted appears and the printer stops printing.

On • A toner cartridge has almost reached its 
estimated cartridge lifea. It is recommended to 
replace the toner cartridge. (See "Replacing 
the toner cartridge" on page 78.)

• A paper jam has occurred. (See "Clearing 
paper jams" on page 65.)

• The cover is opened. Close the cover.
• There is no paper in the tray. Load paper in 

the tray.
• The machine has stopped due to a major 

error. Check the display message. (See 
"Understanding display messages" on 
page 67.) 

FUNCTION DESCRIPTION

Cancel print job Press  (stop button) during printing. 
The red LED blinks while the print job is 
cleared from both the machine and the 
computer and then the machine returns 
to ready mode. This may take some 
time depending on the size of the print 
job.

Manual print Press  (stop button) each time you 
load a sheet of paper in the 
Multi-purpose tray when you select 
Manual Feeder for Source from your 
software application.
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2.getting started
This chapter gives you step-by-step instructions for setting up the USB connected machine and software.
This chapter includes:
• Setting up the hardware
• Supplied software
• System requirements

• Installing USB connected machine’s driver
• Sharing your machine locally

  

SETTING UP THE HARDWARE
This section shows the steps to set up the hardware, as is explained in the 
Quick Install Guide. Make sure you read the Quick Install Guide first and 
follow the steps below:
1. Select a stable location.

Select a level, stable place with adequate space for air circulation. Allow 
extra space to open covers and trays. 
The area should be well ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. Do not set the machine close to the 
edge of your desk or table.

Printing is suitable for altitudes under 1,000 m (3,281 ft). Refer to the 
altitude setting to optimize your printing. (See "Altitude adjustment" on 
page 35.)
Place the machine on a flat, stable surface so that there is no incline 
greater than 2 mm (0.08 inch). Otherwise, printing quality may be 
affected.

2. Unpack the machine and check all the enclosed items.
3. Remove tape holding the machine securely.
4. Install the toner cartridge.

5. Load paper. (See "Loading paper in the tray" on page 38.)
6. Make sure that all cables are connected to the machine. 
7. Turn the machine on.

SUPPLIED SOFTWARE

• Printer driver : Use this driver to take full advantage of 
your machine’s features.

• PostScript Printer Driver : Use the PostScript driver 
to print documents with complex fonts and graphics in 
the PS language. (PostScript printer description file is 
included.)

• Smart Panel : This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• Direct Printing Utility : This program allows you to 
print PDF files directly.

• SetIP : Use this program to set your machine’s TCP/IP 
addresses.

• PostScript Printer Driver : Use this file to run your 
machine from a Macintosh computer and print 
documents. (PostScript printer description file is 
included.)

• Smart Panel : This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• Unified Linux Driver : Use this driver to take full 
advantage of your machine’s features.

•  Printer Description (PPD) file : Use this file to run 
your machine from a Linux computer and print 
documents.

• Smart Panel : This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

After you have set up your machine and connected it to your computer. You 
must install the printer software using the supplied CD . The software CD 
provides you with the following software.

SYSTEM REQUIREMENTS
Before you begin, ensure that your system meets the following 
requirements:

OS CONTENTS

Windows

Macintosh

Linux
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Windows
Your machine supports the following Windows operating systems.

 

• Internet Explorer 5.0 or higher is the minimum requirement for all 
Windows operating systems.

• Users who have an administrator right can install the software.
• Windows Terminal Services is compatible with this machine.

Macintosh

Linux

INSTALLING USB CONNECTED MACHINE’S 
DRIVER
A locally connected machine is a machine directly attached to your 
computer using the USB cable. If your machine is attached to a network, 
skip the following steps below and go on to installing network connected 
machine’s driver. (See "Installing network connected machine’s driver" on 
page 32.)

 

Selecting Custom installation allows you to choose programs to 
install. 
Only use an USB cable no longer then 3m (118 inch. ).

Windows
You can install the machine software using the typical or custom method.
The following steps below are recommended for most users who use a 
machine directly connected to your computer. All components necessary for 
machine operations will be installed.
1. Make sure that the machine is connected to your computer and powered 

on.

 

If the “New Hardware Wizard” window appears during the 
installation procedure, click in the upper right corner of the box 
to close the window, or click Cancel.

2. Insert the supplied software CD into your CD-ROM drive.
• The software CD should automatically run and an installation window 

appear.
• If the installation window does not appear, click Start and then Run. 

Type X:\Setup.exe, replacing “X” with the letter which represents 
your drive. Click OK.

• If you use Windows Vista, click Start > All programs > Accessories 
> Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your drive and click OK.

• If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

OPERATING 
SYSTEM

REQUIREMENT (RECOMMENDED)

CPU RAM FREE HDD 
SPACE

Windows 
2000

Pentium II 400 MHz 
(Pentium III 933 MHz)

64 MB  
(128 MB)

600 MB

Windows XP Pentium III 933 MHz 
(Pentium IV 1 GHz)

128 MB  
(256 MB)

1.5 GB

Windows 
Server 2003

Pentium III 933 MHz 
(Pentium IV 1 GHz)

128 MB  
(512 MB)

1.25 GB to  
2 GB

Windows 
Vista

Pentium IV 3 GHz 512 MB  
(1024 MB)

15 GB

Windows 
Server 2008

Pentium IV 1 GHz
(Pentium IV 2 GHz)

512 MB
(2048 MB)

10 GB

OPERATING 
SYSTEM

REQUIREMENTS (RECOMMENDED)

CPU RAM FREE HDD 
SPACE

Mac OS X 
10.4 or lower

• Intel 
Processors

• PowerPC G4/ 
G5

• 128 MB for a 
PowerPC based 
Mac (512 MB)

• 512 MB for a 
Intel-based Mac 
(1 GB)

1 GB

Mac OS X 
10.5

• Intel 
Processors

• 867 MHz or 
faster Power 
PC G4/ G5

512 MB (1 GB) 1 GB

ITEM REQUIREMENTS

Operating 
system

RedHat 8.0, 9.0 (32bit)
RedHat Enterprise Linux WS 4, 5 (32/64bit)
Fedora Core 1~7 (32/64bit)
Mandrake 9.2 (32bit), 10.0, 10.1 (32/64bit)
Mandriva 2005, 2006, 2007 (32/64bit)
SuSE Linux 8.2, 9.0, 9.1 (32bit)
SuSE Linux 9.2, 9.3, 10.0, 10.1, 10.2 (32/64bit)
SuSE Linux Enterprise Desktop 9, 10 (32/64bit)
Ubuntu 6.06, 6.10, 7.04 (32/64bit)
Debian 3.1, 4.0 (32/64bit)

CPU Pentium IV 2.4GHz (IntelCore2)

RAM 512 MB (1024 MB)

Free HDD space 1 GB (2GB)
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3. Click Next.

If necessary, select a language from the drop-down list.
4. Select Typical installation for a local printer. and then click Next.

 

If your machine is not already connected to the computer, the 
following window will appear.

• After connecting the machine, click Next.
• If you don’t want to connect the machine at this time, click 

Next, and No on the following screen. The installation will then 
start and a test page will not be printed at the end of the 
installation.

• The installation window that appears in this User’s Guide may 
differ depending on the machine and interface in use.

5. After the installation is finished, a window asking you to print a test page 
appears. If you choose to print a test page, select the checkbox and click 
Next. Otherwise, just click Next and skip. 

6. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

7. To register as a user of the machine in order to receive information from 
Samsung, select the checkbox and click Finish. You are now registered 
to the Samsung web site.

8. Otherwise, just click Finish. 

 

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
For windows follow the steps below to uninstall the driver.
a) Make sure that the machine is connected to your machine and 

powered on.
b) From the Start menu, select Programs or All Programs > your 

printer driver name > Maintenance.
c) Select Remove and click Next.

You will see a component list so that you can remove any item 
individually.

d) Select the components you want to remove and then click Next.
e) When your computer asks you to confirm your selection, click Yes.

The selected driver and all of its components are removed from 
your computer.

f) After the software is removed, click Finish. 

Macintosh
The software CD that came with your machine provides you with the PPD 
file that allows you to use the CUPS driver or Apple LaserWriter driver (only 
available when you use a machine which supports the PostScript driver) for 
printing on a Macintosh computer. 

Mac OS 8.6~9.2
1. Make sure that the machine is connected to your computer and 

powered on.
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Macintosh 

desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the Installer Classic icon.
6. The Samsung Installer window opens. Click Continue.
7. Select Easy Install and click Install. 
8. After the installation is finished, click Quit.
9. After the installation is finished, click Restart.
10. Open the Macintosh HD and double-click Applications.
11. Double-click Utilities.
12. Double-click Desktop Printer Utility 
13.  Select LaserWriter 8, and select Printer (USB) in the list box. Then 

click OK.
14. Click Change in the USB Printer Selection section. The name of 

your machine appears in the list.
15. Click your machine, and click OK.
16. Click Auto Setup in the PostScript Printer Description (PPD) File 

section. If Auto Setup does not work properly, click Select PPD and 
choose your machine.

17. Click Add.
18. When the setup is completed, click Create.
19.  Click Save.

 

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow steps below to uninstall the driver for Macintosh.
a) Make sure that the machine is connected to your computer and 
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powered on.
b) Insert the supplied software CD into your CD-ROM drive.
c) Double-click CD-ROM icon that appears on your Macintosh 

desktop.
d) Double-click the MAC_Installer folder.
e) Double-click the Installer Classic icon.
f) Enter the password and click OK.
g) The Samsung Installer window opens. Click Continue.
h) Select Uninstall and click Uninstall. 
i) When the message which warns that all applications will close 

on your computer appears, Click Continue.
j) When the uninstall is done, click Quit.

Mac OS X 10.1 or higher
1. Make sure that the machine is connected to your computer and 

powered on.
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Macintosh 

desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the installer icon.

• For Mac OS 10.1 ~ 10.2, double-click the Installer OS X 
10.1_10.2icon.

• For Mac OS 10.3~10.5, double-click the  Installer OS X icon.
6. Enter the password and click OK.
7. The Samsung Installer window opens. Click Continue.
8. Select Easy Install and click Install. Easy Install is recommended 

for most users. All components necessary for machine operations 
will be installed. 
If you select Custom Install, you can choose individual components 
to install.

9. When the message which warns that all applications will close on 
your computer appears, click Continue.

10. After the installation is finished, click Restart.
11. Open the Applications folder > Utilities > Print Setup Utility.

• For Mac OS X 10.5, open the Applications folder > System 
Preferences and click Print & Fax.

12. Click Add on the Printer List.
• For Mac OS X 10.5, click the “+” icon; a display window will pop 

up. 
13. For Mac OS X 10.3, select the USB tab. 

• For Mac OS X10.4, click Default Browser and find the USB 
connection.

• For Mac OS X 10.5, click Default and find the USB connection.
14. For Mac OS X 10.3, if Auto Select does not work properly, select 

Samsung in Printer Model and your machine name in Model 
Name.
• For Mac OS X 10.4, if Auto Select does not work properly, select 

Samsung in Print Using and your machine name in Model. 
• For Mac OS X 10.5, if Auto Select does not work properly, select 

Select a driver to use... and your machine name in Print Using. 
Your machine appears on the Printer List, and is set as the default 
machine.

15. Click Add.

 

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 

Follow steps below to uninstall the driver for Macintosh.
a) Make sure that the machine is connected to your computer and 

powered on.
b) Insert the supplied software CD into your CD-ROM drive.
c) Double-click CD-ROM icon that appears on your Macintosh 

desktop.
d) Double-click the MAC_Installer folder.
e) Double-click the installer icon.

For Mac OS 10.1 ~ 10.2, double-click the Installer OS X 
10.1_10.2 icon.
For Mac OS 10.3~10.5, double-click the  Installer OS X icon.

f) Enter the password and click OK.
g) The Samsung Installer window opens. Click Continue.
h) Select Uninstall and click Uninstall. 
i) When the message which warns that all applications will close 

on your computer appears, Click Continue.
j) When the uninstall is done, click Quit.

Linux
Follow the steps below to install the driver for Linux. While installing the 
driver, the Unified Linux Driver package will automatically be installed as 
well. 

 

The supplied software CD provides you with the Unified Linux Driver 
package for using your machine with a Linux computer easily in UI 
based management tool. (See "Using the Unified Linux Driver 
Configurator" on page 58.)

1. Make sure that the machine is connected to your computer and powered 
on.

2. When the Administrator Login window appears, type in root in the 
Login field and enter the system password.

 

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

3. Insert the supplied software CD into your CD-ROM drive.
The software CD will run automatically.

If the software CD does not run automatically, click the  icon at the 
bottom of the desktop. When the Terminal screen appears, type in the 
following:
If the software CD is secondary master and the location to mount is 
/mnt/cdrom,
[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom
[root@localhost root]#cd /mnt/cdrom/Linux
[root@localhost Linux]#./install.sh
If you still failed to run the software CD , type the followings in sequence:
[root@localhost root]#umount /dev/hdc
[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom

 

The installation program runs automatically if you have an autorun 
software package installed and configured.
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4. When the welcome screen appears, click Next.

5. When the installation is complete, click Finish.
The installation program has added the Unified Driver Configurator desktop 
icon and the Unified Driver group to the system menu for your convenience. 
If you have any difficulties, consult the on screen help that is available 
through your system menu or can otherwise be called from the driver 
package Windows applications, such as Unified Driver Configurator or 
Image Manager.

 

Installing the driver in the text mode:
• If you do not use the graphical interface or have been unable to 

install the driver, you have to use the driver in the text mode.
• Follow the steps 1 to 3, then type [root@localhost Linux]# 

./install.sh. Follow the instructions on the terminal screen. The 
installation is completed.

• When you want to uninstall the driver, follow the installation 
instructions above, but type [root@localhost Linux]# ./uninstall.sh 
on the terminal screen.

 

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow the steps below steps to uninstall the driver for Linux.
a) Make sure that the machine is connected to your computer and 

powered on.
b) When the Administrator Login window appears, type in “root” in 

the Login field and enter the system password.
You must log in as a super user (root) to uninstall the printer driver. 
If you are not a super user, ask your system administrator.

c) Insert the supplied software CD into your CD-ROM drive.
The software CD will run automatically.
If the software CD does not run automatically, click the  icon at 
the bottom of the desktop. When the Terminal screen appears, 
type in:
If the software CD is secondary master and the location to mount 
is /mnt/cdrom,
[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom
[root@localhost root]#cd /mnt/cdrom/Linux
[root@localhost Linux]#./uninstall.sh
The installation program runs automatically if you have an autorun 
software package installed and configured.

d) Click Uninstall.
e) Click Next. 
f) Click Finish.

SHARING YOUR MACHINE LOCALLY

 

1

 

2

Follow the steps below to set up the computers to share your machine 
locally.
If the Host computer is directly connected to the machine with USB cable 
and is also connected to the local network environment, the client computer 
connected to the local network can use the shared machine through the 
host computer to print. 

Windows
Setting up a host computer
1. Install your printer driver. (See "Installing USB connected machine’s 

driver" on page 26, "Installing network connected machine’s driver" 
on page 32.)

2. Click the Windows Start menu. 
3. For Windows 2000, select Settings > Printers . 

• For Windows XP/2003 select Printer and Faxes. 
• For Windows Vista select Control Panel > Hardware and 

Sound > Printers. 
4. Double-click your printer driver icon. 
5. From the Printer menu, select Sharing....
6. Check the Share this printer.
7. Fill in the Shared Name field. Click OK.

Setting up a client computer
1. Install your printer driver. (See "Installing USB connected machine’s 

driver" on page 26, "Installing network connected machine’s driver" 
on page 32.)

2. Click the Windows Start menu. 
3. Select All programs > Accessories > Window Explorer.
4. Enter the IP address of the host computer in the address bar and 

press Enter in your keyboard. 

 

In case host computer requires User name and Password, fill 
in User ID and password of the host computer account.

5. Right click the printer icon you want to share and select Connect.
6. If a set up complete message appears, click OK. 
7. Open the file you want to print and start printing. 

Macintosh

 

The following steps are for Mac OS X 10.5. Refer to Mac Help for 
other OS versions. 

Host computer A computer which is directly connected to 
the machine by USB cable.

Client computers Computers which use the machine shared 
through the server computer. 
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Setting up a host computer
1. Install your printer driver. (See "Macintosh" on page 27.)
2. Open the Applications folder > System Preferences and click 

Print & Fax. 
3. Select the printer to share in the Printers list. 
4. Select Share this printer.

Setting up a client computer
1. Install your printer driver. (See "Macintosh" on page 27.)
2. Open the Applications folder > System Preferences and click 

Print & Fax. 
3. Click the “+” icon. 

A display window showing the name of your shared printer appears.
4. Select your machine and click Add. 



Network setup_ 31

3.network setup
This chapter gives you step-by-step instructions for setting up the network connected machine and software.
This chapter includes:
• Network environment
• Introducing useful network programs

• Configuring TCP/IP
• Installing network connected machine’s driver

  

NETWORK ENVIRONMENT
You can use network after connecting network cable to a corresponding 
port on your machine. 

You need to set up the network protocols on the machine to use it as your 
network machine. You can set up the basic network settings through the 
machine's control panel.
The following table shows the network environments supported by the 
machine:

 

If you want to setup DHCP network protocol, go to the 
http://developer.apple.com/networking/bonjour/download/, select the 
program Bonjour for Windows due to your computer operating system, 
and install the program. This program will allow you to fix the network 
parameter automatically. Follow the instruction in the installation 
window. This program does not support Linux.

INTRODUCING USEFUL NETWORK PROGRAMS
There are several programs available to setup the network settings easily in 
network environment. For the network administrator especially, managing 
several machines on the network is possible.

SyncThru™ Web Service
Web server embedded on your network print server, which allows you to:
• Configure the network parameters necessary for the machine to connect 

to various network environments.
• Customize machine settings.

(See "Using SyncThru™ Web Service" on page 56.)

SyncThru™ Web Admin Service
Web-based machine management solution for network administrators. 
SyncThru™ Web Admin Service provides you with an efficient way of 
managing network devices and lets you remotely monitor and troubleshoot 
network machines from any site with corporate internet access. Download 
this program from http://solution.samsungprinter.com.

SetIP
This utility program allows you to select a network interface and manually 
configure the IP addresses for use with the TCP/IP protocol. (See "Using 
SetIP program" on page 57.)

CONFIGURING TCP/IP
When you connect your machine to a network, you must first configure the 
TCP/IP settings for the machine. After you have assigned and verified the 
TCP/IP settings, you are ready to install the software on each computer on 
the network.

Setting the network address

 

Contact the network administrator if you are not sure how to configure.
You can set up TCP/IP network parameters, follow the steps below:

1. Make sure your machine is connected to the network with an RJ-45 
Ethernet cable. 

2. Make sure you have turned on the machine. 

3. Press the  on the control panel until Network appears on the bottom 
line of the display and press OK.

4. Press the left/right arrow until TCP/IP appears and press OK. 
5. Press the left/right arrow until Static appears and press OK.
6. Set the first byte between 0 and 255 using the left/right arrow and press 

OK.
Repeat this to complete the address from the 1st byte to the 4th byte.

 

If you press and hold one of the left/right arrows, the digits chnage 
in units of ten.

7. When you have finished, press OK.
Repeat step 6 and 7 to configure the other TCP/IP parameters: subnet 
mask and gateway address. 

ITEM REQUIREMENTS

Network interface Ethernet 10/100 Base-TX

Network operating system • Windows 2000/XP/2003/Vista
• Various Linux OS
• Mac OS 8.6~9.2, Mac OS X 10.1 ~ 10.5

Network protocols • TCP/IP on Windows 
• IPP
• DHCP
• SNMP
• BOOTP

http://developer.apple.com/networking/bonjour/download/
http://solution.samsungprinter.com
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INSTALLING NETWORK CONNECTED 
MACHINE’S DRIVER

 

Selecting Custom installation allows you to choose programs to 
install. 

Windows
You can set up the machine driver, follow the steps below. 
This is recommended for most users. All components necessary for 
machine operations will be installed. 
1. Make sure that the machine is connected to your network and powered 

on. Also, your machine’s IP address should have been set. For details 
about connecting to the network, see the supplied machine’s Quick 
Install Guide.

2. Insert the supplied software CD into your CD-ROM drive.
• The software CD should automatically run and an installation window 

appear.
• If the installation window does not appear, click Start and then Run. 

Type X:\Setup.exe, replacing “X” with the letter, which represents 
your drive. Click OK.

• If you use Windows Vista, click Start > All programs > Accessories 
> Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your drive and click OK.

• If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

3. Click Next. 

• If necessary, select a language from the drop-down list.

4. Select Typical installation for a network printer. Click Next.

5. The list of machines available on the network appears. Select the 
machine you want to install from the list and then click Next. 

 

• If you do not see your machine on the list, click Update to 
refresh the list, or select Add TCP/IP Port to add your machine 
to the network. To add the machine to the network, enter the 
port name and the IP address for the machine. To verify your 
machine’s IP address or the MAC address, print a Network 
Configuration page.

• To find a shared machine (UNC Path), select Shared Printer 
[UNC] and enter the shared name manually or find a shared 
printer by clicking the Browse button.

• If you cannot find your machine in network, turn off the firewall 
and click Update. For Windows operating system, click Start > 
Control Panel > Windows Firewall, and inactivate this option. 
For other operating system, refer to its on-line guide.

6. After the installation is finished, a window asking you to print a test page 
appears. If you choose to print a test page, select the checkbox and click 
Next. Otherwise, just click Finish.

 

If your printer driver doesn’t work properly after setup has been 
completed, reinstall the printer driver. 

Macintosh
Mac OS 8.6~9.2
1. Make sure that the machine is connected to your network and 

powered on. Also, your machine’s IP address should have been set. 
2. Insert the supplied software CD into your CD-ROM drive.
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3. Double-click the CD-ROM icon that appears on your Macintosh 
desktop.

4. Double-click the MAC_Installer folder.
5. Double-click the Installer Classic icon.
6. The Samsung Installer window opens. Click Continue.
7. Select Easy Install and click Install. 
8. After the installation is finished, click Quit.
9.  From the Apple menu, select Chooser.
10. Click LaserWriter 8 (the PostScript driver provided with your 

Macintosh).
The name of your printer appears in the list

11. Select SEC000xxxxxxxxx from the printer box (where the 
xxxxxxxxx varies depending on each of the products) and Click 
Select. 
If Auto Setup does not work properly, click Select
PPD, choose your machine and click OK.

12. When the setup is completed, you see your machine icon is created 
as a desktop printer.

13.  Close the Chooser.
14. When a message window appears telling you that you have changed 

your current printer, click OK.

 

If the printer driver does not work properly, uninstall the driver 
and reinstall it. 
Follow steps below to uninstall the driver for Macintosh.
a) Make sure that the machine is connected to your computer 

and powered on.
b) Insert the supplied software CD into your CD-ROM drive.
c) Double-click CD-ROM icon that appears on your Macintosh 

desktop.
d) Double-click the MAC_Installer folder.
e) Double-click the Installer Classic icon.
f) Enter the password and click OK.
g) The Samsung Installer window opens. Click Continue.
h) Select Uninstall and click Uninstall. 
i) When the message which warns that all applications will 

close on your computer appears, Click Continue.
j) When the uninstall is done, click Quit.

Mac OS X 10.1 or higher
1. Make sure that the machine is connected to your network and 

powered on. Also, your machine’s IP address should have been set. 
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Macintosh 

desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the installer icon.

• For Mac OS 10.1 ~ 10.2, double-click the Installer OS X 
10.1_10.2icon.

• For Mac OS 10.3~10.5, double-click the  Installer OS X icon.
6. Enter the password and click OK.
7. The Samsung Installer window opens. Click Continue.
8. Select Easy Install and click Install. Easy Install is recommended 

for most users. All components necessary for machine operations 
will be installed. 
• If you select Custom Install, you can choose individual 

components to install.
9. The message which warns that all applications will close on your 

computer appears. Click Continue.
10. After the installation is finished, click Quit.
11. Open the Applications folder > Utilities > Print Setup Utility.

• For Mac OS X 10.5, open the Applications folder > System 
Preferences and click Print & Fax.

12. Click Add on the Printer List.
• For Mac OS X 10.5, click the “+” icon; a display window will pop 

up. 
13. For Mac OS X 10.1~10.3, select the IP Printing tab. 

• For Mac OS X10.4, click IP Printer.
• For Mac OS X 10.5, click IP.

14. Select Socket/HP Jet Direct in Printer Type.

 

When printing a document containing many pages, printing 
performance may be enhanced by choosing Socket for Printer 
Type option.

15. Enter the machine’s IP address in the Printer Address field.
16. Enter the queue name in the Queue Name field. If you cannot 

determine the queue name for your machine server, try using the 
default queue first.

17. For Mac OS X 10.3, if Auto Select does not work properly, select 
Samsung in Printer Model and your machine name in Model 
Name.
• For Mac OS X 10.4, if Auto Select does not work properly, select 

Samsung in Print Using and your machine name in Model. 
• For Mac OS X 10.5, if Auto Select does not work properly, select 

Select a driver to use... and your machine name in Print Using. 
Your machine appears on the Printer List, and is set as the default 
machine.

18. Click Add.

 

If the printer driver does not work properly, uninstall the driver 
and reinstall it. 
Follow steps below to uninstall the driver for Macintosh.
a) Make sure that the machine is connected to your computer 

and powered on.
b) Insert the supplied software CD into your CD-ROM drive.
c) Double-click CD-ROM icon that appears on your Macintosh 

desktop.
d) Double-click the MAC_Installer folder.
e) Double-click the installer icon.
For Mac OS 10.1 ~ 10.2, double-click the Installer OS X 
10.1_10.2 icon.
For Mac OS 10.3~10.5, double-click the  Installer OS X icon.
f) Enter the password and click OK.
g) The Samsung Installer window opens. Click Continue.
h) Select Uninstall and click Uninstall. 
i) When the message which warns that all applications will 

close on your computer appears, Click Continue.
j) When the uninstall is done, click Quit.
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Linux
1. Make sure that the machine is connected to your network and powered 

on. Also, your machine’s IP address should have been set. 
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click CD-ROM icon that appears on your Linux desktop.
4. Double-click the Linux folder.
5. Double-click the install.sh icon.
6. The Samsung Installer window opens. Click Continue.
7. The Add printer wizard window opens. Click Next.
8. Select Network printer and click Search button.
9. The Printer’s IP address and model name appears on list field.
10. Select your machine and click Next.
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4.basic setup
After installation is complete, you may want to set the machine’s default settings. Refer to the next section if you would like 
to set or change values. This chapter gives you step-by-step instructions for setting up the machine.
This chapter includes:
• Altitude adjustment
• Changing the display language
• Setting job timeout

• Using Power saving feature
• Setting the default tray and paper
• Changing font setting

  

ALTITUDE ADJUSTMENT

0

The print quality is affected by atmospheric pressure, which is determined 
by the height of the machine above sea level. The following information will 
guide you on how to set your machine to the best print quality or best quality 
of print.

Before you set the altitude value, find the altitude where you are using the 
machine.

1. Turn your networked computer on and open the web browser. 
2. Enter your machine's IP address as the URL in a browser.
3. Click Go to access the SyncThru™ Web Service.
4. Click Machine Settings > Setup.
5. Click Altitude Adj.
6. Select the appropriate altitude value.
7. Click Apply. 

 

If your machine is connected via USB cable, set the altitude in 
Altitude Adj. option using the control panel. (See "System setup" 
on page 54.)

CHANGING THE DISPLAY LANGUAGE
To change the language that appears on the display, follow the steps below:

1. Press  until System Setup appears on the bottom line of the display 
and press OK.

2. Press the left/right arrow until Language appears and press OK.
3. Press the left/right arrow until the language you want appears and press 

OK.

4. Press  to return to ready mode.

SETTING JOB TIMEOUT
When there is no input for a certain period of time, the machine exits the 
current menu and goes in to the default settings. You can set the amount of 
time the machine will wait.

1. Press  until System Setup appears on the bottom line of the display 
and press OK.

2. Press the left/right arrow until Job Timeout appears and press OK.
3. Press the left/right arrow until the time setting you want appears.
4. Press OK to save the selection.

5. Press  to return to ready mode.

USING POWER SAVING FEATURE
When you are not using the machine for a while, use this feature to save 
power. 

1. Press  until System Setup appears on the bottom line of the display 
and press OK.

2. Press the left/right arrow until Power Save appears and press OK.
3. Press the left/right arrow until the time setting you want appears.
4. Press OK to save the selection.

5. Press  to return to ready mode.

SETTING THE DEFAULT TRAY AND PAPER
You can select the tray and paper you would like to keep using for printing 
job.

In the control panel
1. Press  until Paper appears on the bottom line of the display and 

press OK.
2. Press the left/right arrow to until Paper Source appears and press OK.
3. Press the left/right arrow until the tray you want appears.
4. Press OK to save the selection.
5. Press the left/right arrow to until Paper Type and press OK.
6. Press the left/right arrow until the paper type you want appears.
7. Press OK to save the selection.

8. Press  to return to ready mode.

1 High 3
2 High 2
3 High 1
4 Normal
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In the computer
Windows
1. Click the Windows Start menu. 
2. For Windows 2000, select Settings > Printers . 

• For Windows XP/2003 select Printer and Faxes. 
• For Windows Vista select Control Panel > Hardware and 

Sound > Printers. 
3. Right-click your machine and press Printing Preferences.
4. Click Paper tab. 
5. Select tray and its options, such as paper size and type.
6. Press OK.

Macintosh
Macintosh does not support this function. Macintosh users need to 
change the default setting manually each time they want to print using 
other settings. 
1. Open a Macintosh application and select the file you want to print.
2. Open the File menu and click Print.
3. Go to Paper Feed Pane.
4. Set appropriate tray from which you want to print.
5. Go to Paper Pane.
6. Set paper type to correspond to the paper loaded in the tray from 

which you want to print.
7. Click Print to print. 

CHANGING FONT SETTING 
Your machine has preset the font for your region or country.
If you want to change the font or set the font for special condition, such as 
the DOS environment, you can change the font setting as follows:

1. Press  until Emulation appears on the bottom line of the display and 
press OK.

2. Press the left/right arrow until the font type you want appears.
3. Press OK to save the selection.

4. Press  to return to machine ready mode.

 

Following information shows the proper font list for corresponding 
languages.
• Russian : CP866, ISO 8859/5 Latin Cyrillic
• Hebrew : Hebrew 15Q, Hebrew-8, Hebrew-7 (Israel only)
• Greek : ISO 8859/7 Latin Greek, PC-8 Latin/Greek
• Arabic & Farsi : HP Arabic-8, Windows Arabic, Code Page 864, 

Farsi, ISO 8859/6 Latin Arabic
• OCR : OCR-A, OCR-B
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5.media and tray
This chapter provides information on how to load print media into your machine.
This chapter includes:
• Selecting print media
• Changing the tray size
• Loading paper in the tray

• Printing on special media
• Setting the paper size and type
• Using the output support

  

SELECTING PRINT MEDIA
You can print on a variety of print media, such as plain paper, envelopes, 
labels, and transparencies. Always use print media that meet the guidelines 
for use with your machine. 

Guidelines to select the print media
Print media that does not meet the guidelines outlined in this user’s guide 
may cause the following problems:
• Poor print quality
• Increased paper jams
• Premature wear on the machine.
Properties, such as weight, composition, grain, and moisture content, are 
important factors that affect the machine’s performance and the output 
quality. When you choose print materials, consider the following:
• The type, size and weight of the print media for your machine are 

described in print media specifications. (See "Print media specifications" 
on page 82.)

• Desired outcome: The print media you choose should be appropriate for 
your project.

• Brightness: Some print media are whiter than others and produce 
sharper, more vibrant images.

• Surface smoothness: The smoothness of the print media affects how 
crisp the printing looks on the paper.

 

• Some print media may meet all of the guidelines in this section and 
still not produce satisfactory results. This may be the result of 
improper handling, unacceptable temperature and humidity levels, 
or other variables over which cannot be controlled.

• Before purchasing large quantities of print media, ensure that it 
meets the requirements specified in this user’s guide. 

 

Using print media that does not meet these specifications may cause 
problems, requiring repairs. Such repairs are not covered by the 
warranty or service agreements.
The amount of paper put into the tray may differ according to media 
type used. (See "Print media specifications" on page 82.)

Media sizes supported in each mode

CHANGING THE TRAY SIZE

1

2

3

4

The tray is preset to Letter or A4 size, depending on your country. To 
change the size, you need to adjust the paper guides.

1. With one hand press and hold the guide lock, and with the other hand, 
hold the paper length guide and support guide together. Slide the paper 
length guide and support guide to locate them in the correct paper size 
slot. 

2. Flex or fan the edge of the paper stack to separate the pages before 
loading originals. Insert the paper into the tray.

MODE SIZE TYPE SOURCE

Duplex 
printinga

a.75 to 90 g/m2 (20~24 lb bond) only 

Letter, A4, 
Legal, US Folio, 
Oficio

Plain, Color, 
Preprinted, 
Recycled, Bond, 
Archive

• tray 1
• optional trays
• multi-purpose tray

1 Paper length guide
2 Support guide
3 Guide lock
4 Paper width guide



Media and tray_ 38

3. After inserting paper into the tray, adjust the support guide so that it 
lightly touches the paper stack.

4. Squeeze the paper width guides and slide them to the desired paper 
size marked at the bottom of the tray.

 

• Do not push the paper width guide too far causing the media to 
warp. 

• If you do not adjust the paper width guide, it may cause paper 
jams.

LOADING PAPER IN THE TRAY
Tray 1 / optional tray
1. Pull out the paper tray . And adjust the tray size to the media size you 

are loading. (See "Changing the tray size" on page 37.)
2. Flex or fan the edge of the paper stack to separate the pages before 

loading originals.

3.  And place paper with the side you want to print facing down.

 

Paper quantity indicator shows the amount of paper in the tray. 

1 Full
2 Empty

4. Set the paper type and size for the tray 1. (See "Setting the paper size 
and type" on page 41.)

 

• If you experience problems with paper feeding, check whether 
the paper meets the media specification. Then try placing one 
sheet at a time in the multi-purpose tray. (See "Print media 
specifications" on page 82.)

• The settings made from the machine driver override the 
settings on the control panel.

Multi-purpose tray
The multi-purpose tray can hold special sizes and types of print material, 
such as postcards, note cards, and envelopes. It is useful for single page 
printing on letterhead or colored paper.

Tips on using the multi-purpose tray
• If you select Manual Feeder for Source from your software 

application, you need to press  each time you print a page and 
load only one type, size and weight of print media at a time in the 
multi-purpose tray.

• To prevent paper jams, do not add paper while printing when there is 
still paper in the multi-purpose tray. This also applies to other types 
of print media.

• Print media should be loaded face up with the top edge going into 
the multi-purpose tray first and be placed in the center of the tray.

• Always load the specified print media only to avoid paper jams and 
print quality problems. (See "Print media specifications" on page 82.)

• Flatten any curl on postcards, envelopes, and labels before loading 
them into the multi-purpose tray.

1. Hold the handle of multi-purpose tray and pull it down to open. Pull 
out the multi-purpose tray paper extension
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2. Squeeze the multi-purpose tray paper width guides and adjust them 
to the width of the paper. Do not force them too much, or the paper 
will bent resulting in a paper jam or skew.

3. Flex or fan the edge of the paper stack to separate the pages before 
loading originals.

4. Load the paper.

 • Do not force the paper beyond the surface with mark 
when loading. 

• When printing the special media, you must follow the 
loading guideline. (See "Printing on special media" on 
page 39.)

• When papers overlap when printing using Multi-purpose 
tray, open tray 1 and remove overlapping papers then try 
printing again. 

• When paper does not feed well while printing, push the 
paper in manually until it starts feeding automatically. 

5. After loading paper, set the paper type and size for the multi-purpose 
tray from the control panel. (See "Setting the paper size and type" on 
page 41.

 

The settings made from the machine driver override the 
settings on the control panel.

6. To print in application, open an application and start the print menu.
7. Open Printing Preferences. (See "Opening Printing Preferences" 

on page 44.)
8. Press the Paper tab in Printing Preferences, and select an 

appropriate paper type. 

 

For example, if you want to use a label, set the paper type to 
Label.

9. Select Manual Feeder in paper source, then press OK.
10. Start printing in application.
11. After printing, close the multi-purpose tray.

PRINTING ON SPECIAL MEDIA
The table below shows the available special media for each tray. 

 

When using special media, we recommend you feed one paper at a 
time. Check the maximum input number of media for each tray. (See 
"Print media specifications" on page 82.)

The media types are shown in the Printing Preferences. This paper type 
option allows you to set the type of paper to be loaded in the tray. This 
setting appears in the list, so that you can select it. This will let you get the 
best quality printout. If not, the desired print quality may not be achieved.
• Plain : Normal plain paper. Select this type if your machine is 

monochrome and printing on the 60 g/m2 (16 lb) cotton paper.
• Thick : 90 to 105 g/m2 (24 to 28 lb) thick paper.
• Thin : 60 to 70 g/m2 (16 to 19 lb) thin paper.
• Bond : 105 to 120 g/m2 (28 to 32 lb) bond. 
• Color : 75 to 90 g/m2 (20 to 24 lb) color-backgrounded paper.
• CardStock : 90 to 163 g/m2 (24 to 43 lb) cardstock. 
• Labels : 120 to 150 g/m2 (32 to 40 lb) labels. 
• Transparency : 138 to 146 g/m2 (37 to 39 lb) transparency paper. 
• Envelope : 75 to 90 g/m2 (20 to 24 lb) envelope.
• Preprinted : 75 to 90 g/m2 (20 to 24 lb) preprinted/letterhead paper.
• Cotton : 75 to 90 g/m2 (20 to 24 lb) preprinted paper.
• Recycled : 75 to 90 g/m2 (20 to 24 lb) recycled paper.
• Archive : 70 to 90 g/m2 (19 to 24 lb) If you need to keep the print-out for 

a long period time, such as archives, select this option. 

TYPES TRAY 1 OPTIONAL 
TRAY

MULTI-PURPOSE 
TRAY

Plain O O O

Thick O O O

Thin O O O

Bond X X O

Color X X O

CardStock X X O

Labels X X O

Transparency X X O

Envelope X X O

Preprinted X X O

Cotton X X O

Recycled O O O

Archive O O O



Media and tray_ 40

Envelope
Successful printing on envelopes depends upon the quality of the 
envelopes. 
To print an envelope, place it flap side down with the stamp area on the 
bottom right side.

If envelopes are printed out with wrinkles, crease or black bold lines, open 
the rear cover and pull down the pressure lever on the right side about 90 
degrees and try printing again. Keep the rear cover opened during printing. 

• When selecting envelopes, consider the following factors:
- Weight : The weight of the envelope paper should not exceed 

90 g/m2 otherwise, jam may occur.
- Construction : Prior to printing, envelopes should lie flat with less 

than 6 mm curl, and should not contain air.
- Condition : Envelopes should not be wrinkled, nicked, nor 

damaged.
- Temperature : Use envelopes that are compatible with the heat and 

pressure of the machine during operation.
• Use only well-constructed envelopes with sharp-and well-creased folds.
• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, windows, coated lining, 

self-adhesive seals, or other synthetic materials.
• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope extends all the way to 

the corner of the envelope.

1  Acceptable
2  Unacceptable

• Envelopes with a peel-off adhesive strip or with more than one flap that 
folds over to seal must use adhesives compatible with the machine’s 
fusing temperature for 0.1 second. To view the fusing temperature, 

check your machine’s specification. (See "General specifications" on 
page 80.) The extra flaps and strips might cause wrinkling, creasing, or 
jams, and may even damage the fuser.

• For the best print quality, position margins no closer than 15 mm from 
the edges of the envelope.

• Avoid printing over the area where the envelope’s seams meet.

Transparency
To avoid damaging the machine, use only transparencies designed for use 
in laser printers.

• Transparencies used in the machine must be able to withstand 
machine’s fusing temperature.

• Place them on a flat surface after removing them from the machine.
• Do not leave unused transparencies in the paper tray for long periods of 

time. Dust and dirt may accumulate on them, resulting in spotty printing.
• To avoid smudging caused by fingerprints, handle them carefully.
• To avoid fading, do not expose printed transparencies to prolonged 

sunlight.
• Ensure that transparencies are not wrinkled, curled, or have any torn 

edges.
• Do not use transparencies that separates from the backing sheet.
• To prevent transparencies from sticking to each other, do not let the 

printed sheets stack up as they are begin printed out. 
• Recommended media: Transparency for a color laser printer by Xerox, 

such as 3R 91331(A4), 3R 2780(Letter)

Labels
To avoid damaging the machine, use only labels designed for use in laser 
machines.

• When selecting labels, consider the following factors:
- Adhesives : The adhesive material should be stable at your 

machine’s fusing temperature. Check your machine’s specification to 
view the fusing temperature. (See "General specifications" on 
page 80.)

- Arrangement : Only use labels with no exposed backing between 
them. Labels can peel off sheets that have spaces between the 
labels, causing serious jams.

- Curl : Prior to printing, labels must lie flat with no more than 13 mm 
of curl in any direction.

- Condition : Do not use labels with wrinkles, bubbles, or other 

1 Pressure lever
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indications of separation.
• Make sure that there is no exposed adhesive material between labels. 

Exposed areas can cause labels to peel off during printing, which can 
cause paper jams. Exposed adhesive can also cause damage to 
machine components.

• Do not run a sheet of labels through the machine more than once. The 
adhesive backing is designed for only a single pass through the 
machine.

• Do not use labels that are separating from the backing sheet or are 
wrinkled, bubbled, or otherwise damaged.

Card stock/ Custom-sized paper

• Do not print on media smaller than 76 mm (2.99 inches) wide or 127 mm 
(5 inches) long.

• In the software application, set margins at least 6.4 mm (0.25 inches) 
away from the edges of the material.

Letterhead / Preprinted paper
Letterhead 

Preprinted paper
When loading preprinted paper, printed side should be facing down with 
an uncurled edge at the front. If you experience problems with paper 
feed, turn the paper around. Note that print quality is not guaranteed.

• Letterhead/ Preprinted paper must be printed with heat-resistant ink 
that will not melt, vaporize, or release hazardous emissions when 
subjected to the machine’s fusing temperature for 0.1 second. Check 
your machine’s specification to view the fusing temperature. (See 
"General specifications" on page 80.)

• Letterhead/ Preprinted paper ink must be non-flammable and should 
not adversely affect machine rollers.

• Forms and letterhead should be sealed in a moisture-proof wrapping 
to prevent changes during storage.

• Before you load letterhead/preprinted paper, verify that the ink on the 
paper is dry. During the fusing process, wet ink can come off 
preprinted paper, reducing print quality.

Photo
• Make sure not to use the inkjet photo paper with this machine. It could 

cause damage to the machine. 

Glossy

 

Load one paper to the multi-purpose tray at a time, glossy side facing 
up. 

• Recommended media: Glossy paper (Letter) for this machine by HP 
Brochure Paper (Product: Q6611A) only.

• Recommended media: Glossy paper (A4) for this machine by HP 
Superior Paper 160 glossy (Product: Q6616A).

SETTING THE PAPER SIZE AND TYPE
After loading paper in the paper tray, set the paper size and type using the 
control panel buttons. 

 

The settings made from the machine driver override the settings on 
the control panel.

1. Press  until Paper appears on the bottom line of the display and 
press OK. 

2. Press left/right arrow until Paper Size appears and press OK.
3. Press left/right arrow until the paper size you are using appears and 

Press OK.
4. Press left/right arrow until Paper Type appears and press OK.
5. Press left/right arrow until the paper type you are using appears and 

Press OK.

6. Press  to return to ready mode.

 

If you want to use special-sized paper-such as a billing paper, select 
Custom in the Paper tab in the Printing Preferences. (See "Opening 

SINGLE-SIDED DOUBLE-SIDED

Tray1/Optio
nal tray

Face down Face up

Multi-purpo
se tray

Face up Face down
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Printing Preferences" on page 44.)

USING THE OUTPUT SUPPORT

 

The surface of the output tray may become hot if you print a large 
number of pages at once. Make sure that you do not touch the 
surface, and do not allow children near it.

The printed pages stack on the output support, and the output support will 
help the printed pages to align. Pull out the output support and expend it. 

Stacking papers firmly
If you use a machine in a humid area, or you are using the damp print media 
caused by a high humidity, the print-outs on the output tray may be curled 
and may not be stacked properly. In this case, you can set the machine to 
use the Paper Stacking function to let print-outs stacked firmly. But, using 
this function will make the print speed slow.

1. Press  until System Setup appears on the bottom line of the display 
and press OK.

2. Press the left/right arrow until Maintenance appears and press OK.
3. Press the left/right arrow until Paper Stacking appears and press OK.
4. Press the left/right arrow to select On or Off and press OK.

5. Press  to return to ready mode.
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6.printing
This chapter explains common printing tasks.
This chapter includes:
• Printer driver features
• Basic printing
• Opening Printing Preferences
• Using help
• Using special print features
• Changing the default print settings

• Setting your machine as a default machine
• Printing to a file (PRN)
• Macintosh printing
• Linux printing
• Printing with PS driver

  

 

The procedures in this chapter are mainly based on Windows XP.

PRINTER DRIVER FEATURES
Your printer drivers support the following standard features:
• Paper orientation, size, source, and media type selection
• Number of copies
In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer 
drivers:

 

Some models or operating system may not support the certain 
feature(s) in the following table.

PCL printer driver

PostScript printer driver

BASIC PRINTING
Your machine allows you to print from various Windows, Macintosh, or 
Linux applications. The exact steps for printing a document may vary 
depending on the application you use.

 

• Your Printing Preferences window that appears in this user’s 
guide may differ depending on the machine in use. However, the 
composition of the Printing Preferences window is similar. Check 
the operating system(s) that are compatible with your machine. 
Refer to the OS compatibility section of Printer specifications . 
(See "Printer specifications" on page 81.) 

• When you select an option in Printing Preferences, you may see 
a warning mark,  ,or  . An exclamation mark ( ) means you 
can select that certain option but it is not recommended, and  ( ) 
mark means you cannot select that option due to the machine’s 
setting or environment.

The following procedure describes the general steps required for printing 
from various Windows applications. 

 

Macintosh basic printing. (See "Macintosh printing" on page 48.)
Linux basic printing. (See "Linux printing" on page 49.)

The following Printing Preferences window is for Notepad in Windows XP. 
Your Printing Preferences window may differ, depending on your 
operating system or the application you are using. 
1. Open the document you want to print.
2. Select Print from the File menu. The Print window appears. 

FEATURE WINDOWS

Machine quality option O

Poster printing O

Multiple pages per sheet O

Booklet printing O

Fit to page printing O

Reduce and enlarge printing O

Different source for first page O

Watermark O

Overlay O

Double-sided printing (duplex) O

FEATURE WINDOWS LINUX MACINTOSH

Machine quality option O O O

Poster printing X X X

Multiple pages per sheet O O
(2, 4)

O

Fit to page printing X O O

Reduce and enlarge 
printing

O X O

Different source for first 
page

X X O

Watermark X X X

Overlay X X X

Double-sided printing 
(duplex)a

O O O

a.The machine with Duplex feature prints both side of a paper.

FEATURE WINDOWS LINUX MACINTOSH
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3. Select your machine from the Select Printer list.

The basic print settings including the number of copies and print range 
are selected within the Print window. 

 

To take advantage of the printer features provided by your printer 
driver, click Properties or Preferences in the application’s Print 
window to change the print setting. (See "Opening Printing 
Preferences" on page 44. )

4. To start the print job, click Print in the Print window.

Canceling a print job
If the print job is waiting in a print queue or print spooler, delete the job as 
follows:
1. Click the Windows Start menu.

• For Windows 2000, select Settings > Printers.
• For Windows XP/2003, select Printers and Faxes.
• For Windows Vista, select Control Panel > Hardware and Sound > 

Printers.
2. Double-click your machine.
3. From the Document menu, select Cancel.

 

You can also access this window by simply double-clicking the 
machine icon ( ) in the Windows task bar. 
You can also cancel the current job by pressing  on the control 
panel.

OPENING PRINTING PREFERENCES
You can preview the settings you selected on the upper right of the Printing 
Preferences.
1. Open the document you want to print.
2. Select Print from the File menu. The Print window appears. 
3. Select your machine from the Select Printer. 
4. Click Properties or Preferences. 

Using a favorite setting
The Favorites option, which is visible on each preferences tab except for 
Samsung tab, allows you to save the current preferences settings for future 
use. 
To save a Favorites item:

1. Change the settings as needed on each tab. 
2. Enter a name for the item in the Favorites input box. 

3. Click Save. When you save Favorites, all current driver settings are 
saved.

To use a saved setting, select it from the Favorites drop down list. The 
machine is now set to print according to the setting you selected.
To delete saved setting, select it from the Favorites drop down list and click 
Delete. 
You can also restore the printer driver’s default settings by selecting Printer 
Default Printer from the Favorites drop down list.

Using help
Click the question mark from the upper-right corner of the window and click 
on any option you want to know about. Then a pop up window appears with 
information about that option’s feature which is provided from the driver.

USING SPECIAL PRINT FEATURES
Special print features include:
• "Printing multiple pages on one sheet of paper" on page 44.
• "Printing posters" on page 45.
• "Printing booklets" on page 45.
• "Printing on both sides of paper" on page 45.
• "Change percentage of your document" on page 45.
• "Fitting your document to a selected paper size" on page 46.
• "Using watermarks" on page 46.
• "Using overlay" on page 46.

Printing multiple pages on one sheet of paper
You can select the number of pages to print on a single sheet of paper. To 
print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one 
sheet. 
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening Printing Preferences" on 
page 51.)

2. Click the Layout tab, select Multiple Pages per Side in the Layout 
Type drop-down list.

3. Select the number of pages you want to print per sheet  
(2, 4, 6, 9, or 16) in the Pages per Side drop-down list.

4. Select the page order from the Page Order drop-down list, if necessary. 
5. Check Print Page Border to print a border around each page on the 

sheet.
6. Click the Paper tab, select the Paper Options.
7. Click OK or Print until you exit the Print window.
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Printing posters
This feature allows you to print a single-page document onto 4, 9, or 16 
sheets of paper, for the purpose of pasting the sheets together to form one 
poster-size document.

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening Printing Preferences" on 
page 51.)

2. Click the Layout tab, select Poster Printing in the Layout Type 
drop-down list.

3. Select the page layout you want.
Specification of the page layout:
• Poster <2x2> : Document will be enlarged and be divided into 4 

pages.
• Poster <3x3> : Document will be enlarged and be divided into 9 

pages.
• Poster <4x4> : Document will be enlarged and be divided into 16 

pages.
4. Select the Overlap value. Specify Overlap in millimeters or inches by 

selecting the radio button under the preview image to make it easier to 
paste the sheets together.

5. Click the Paper tab, select the Paper Options.
6. Click OK or Print until you exit the Print window.

7. You can complete the poster by pasting the sheets together.

Printing booklets
This feature prints your document on both sides of a paper and arranges the 
pages so that the paper can be folded in half after printing to produce a 
booklet.

 

If you want to make a booklet, you need to print on Letter, Legal, A4, 
Us Folio, or Oficio sized print media. 

8 9

1. To change the print settings from your software application, access the 
Printing Preferences. (See "Opening Printing Preferences" on 
page 51.)

2. Click the Layout tab, select Booklet Printing from the Layout Type 
drop-down list.

3. Click the Paper tab, select the Paper Options.

 

The Booklet Printing option is not available for all paper sizes. In 
order to find out the available paper size for this feature, select the 

available paper size in the Size option on the Paper tab.
If you select an unavailable paper size, this option can be 
automatically canceled. Select only available paper. (paper without 

 or  mark).
4. Click OK or Print until you exit the Print window.

5. After printing, fold and staple the pages.

Printing on both sides of paper
You can print on both sides of a paper; duplex. Before printing, decide how 
you want your document oriented. You can only use this feature with Letter, 
Legal, A4, US Folio, or Oficio sized paper. 

 

Do not print on both sides of the special media, such as labels, 
envelopes, or thick paper to print on both sides of paper. It may cause 
a paper jam or damage the machine. 

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening Printing Preferences" on 
page 51.)

2. Click the Layout tab.
3. From the Double-sided Printing section, select the binding option you 

want.   
• Printer Default : If you select this option, this feature is determined 

by the setting you’ve made on the control panel of the machine. 
• None 
• Long Edge : This option is the conventional layout used in 

bookbinding.

• Short Edge : This option is the conventional layout used in 
calendars.

• Reverse Double-Sided Printing : Check this option to reverse the 
print order when duplex printing.

4. Click the Paper tab, select the Paper Options.
5. Click OK or Print until you exit the Print window.

 

If your machine does not have a duplex unit, you should complete the 
printing job manually. The machine prints every other page of the 
document first. After that , a message appears on your computer. 
Follow the on-screen instructions to complete the printing job.

Change percentage of your document
 You can change the size of a document to appear larger or smaller on the 
printed page by typing in a percentage you want.
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1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening Printing Preferences" on 
page 51.)

2. Click the Paper tab.
3. Select Reduce/Enlarge in the Printing Type drop-down list. 
4. Enter the scaling rate in the Percentage input box. 

You can also click the up/down arrows to select the scaling rate. 
5. Select the Paper Options.
6. Click OK or Print until you exit the Print window.

Fitting your document to a selected paper size

A

This printer feature allows you to scale your print job to any selected paper 
size regardless of the document size. This can be useful when you want to 
check fine details on a small document. 

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening Printing Preferences" on 
page 51.)

2. Click the Paper tab.
3. Select Fit to Page in the Printing Type drop-down list. 
4. Select the correct size from the Output size drop-down list. 
5. Select the Paper Options.
6. Click OK or Print until you exit the Print window.

Using watermarks
The watermark option allows you to print text over an existing document. 
For example, you use it when you want to have large gray letters reading 
“DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all 
pages of a document. 

There are several predefined watermarks that come with the machine. They 
can be modified, or you can add new ones to the list. 

Using an existing watermark
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening Printing Preferences" on 
page 51.)

2. Click the Extras tab, and select the desired watermark from the 
Watermark drop-down list. You will see the selected watermark in 
the preview image. 

3. Click OK or Print until you exit the Print window.

Creating a watermark
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening Printing Preferences" on 
page 51.)

2. Click the Extras tab, and click the Edit button in the Watermark 
section. The Edit Watermark window appears. 

3. Enter a text message in the Watermark Message box. You can 
enter up to 40 characters. The message displays in the preview 
image.
When the First Page Only box is checked, the watermark prints on 
the first page only.

4. Select watermark options. 
You can select the font name, style, size, and shade from the Font 
Attributes section, as well as set the angle of the watermark from 
the Message Angle section. 

5. Click Add to add a new watermark to the Current Watermarks list.   
6. When you have finished editing, click OK or Print until you exit the 

Print window.
To stop printing the watermark, select (No Watermark) from the 
Watermark drop-down list. 

Editing a watermark
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening Printing Preferences" on 
page 51.)

2. Click the Extras tab, and click the Edit button in the Watermark 
section. The Edit Watermark window appears. 

3. Select the watermark you want to edit from the Current Watermarks 
list and change the watermark message and options. 

4. Click Update to save the changes.
5. Click OK or Print until you exit the Print window. 

Deleting a watermark
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening Printing Preferences" on 
page 51.)

2. Click the Extras tab, and click the Edit button in the Watermark 
section. The Edit Watermark window appears. 

3. Select the watermark you want to delete from the Current 
Watermarks list and click Delete. 

4. Click OK or Print until you exit the Print window.

Using overlay
What is an overlay?
An overlay is text and/or images stored in the computer hard disk drive 
(HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of letterhead paper. Rather 
than using preprinted letterhead, you can create an overlay containing 
exactly the same information that is currently on your letterhead. To print 
a letter with your company’s letterhead, you do not need to load 
preprinted letterhead paper in the machine just print the letterhead 
overlay on your document.
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Creating a new page overlay
To use a page overlay, you must create a new page overlay containing 
your logo or image.
1. Create or open a document containing text or an image for use in a 

new page overlay. Position the items exactly as you wish them to 
appear when printed as an overlay.

2. To save the document as an overlay, access Printing Preferences. 
(See "Opening Printing Preferences" on page 51.)

3. Click the Extras tab, and click the Edit button in the Overlay 
section. The Edit Overlay window appears. 

4. Click Create. 
5. In the Create Overlay window, type a name of up to eight characters 

in the File name box. Select the destination path, if necessary. (The 
default is C:\Formover.)

6. Click Save. The name appears on the Overlay List. 
7. Click OK or Print until you exit the Print window.

8. The file is not printed. Instead, it is stored on your computer hard disk 
drive.

 

The overlay document size must be the same as the document 
you print with the overlay. Do not create an overlay with a 
watermark.

Using a page overlay
After an overlay has been created, it is ready to be printed with your 
document. To print an overlay with a document:
1. Create or open the document you want to print.
2. To change the print settings from your software application, access 

Printing Preferences. (See "Opening Printing Preferences" on 
page 51.)

3. Click the Extras tab. 
4. Select the desired overlay from the Overlay drop-down list. 
5. If the overlay file you want does not appear in the Overlay 

drop-down list, select Edit from the list and click Load Overlay. 
Select the overlay file you want to use. 
If you have stored the overlay file you want to use in an external 
source, you can also load the file when you access the Load 
Overlay window. 
After you select the file, click Open. The file appears in the Overlay 
List box and is available for printing. Select the overlay from the 
Overlay List box. 

6. If necessary, check Confirm Page Overlay When Printing box. If 
this box is checked, a message window appears each time you 
submit a document for printing, asking you to confirm your wish to 
print an overlay on your document. 
If this box is not checked and an overlay has been selected, the 
overlay automatically prints with your document. 

7. Click OK or Print until you exit the Print window. 
The selected overlay prints on your document. 

 

The resolution of the overlay document must be the same as that 
of the document you will print with the overlay.

Deleting a page overlay
You can delete page overlays that you no longer use. 
1. In the Printing Preferences window, click the Extras tab. 
2. Click the Edit button in the Overlay section. The Edit Overlay 

window appears. 
3. Select the overlay you want to delete from the Overlay Listbox. 

4. Click Delete Overlay. 
5. When a confirming message window appears, click Yes.
6. Click OK or Print until you exit the Print window.

CHANGING THE DEFAULT PRINT SETTINGS
1. Click the Windows Start menu.

• For Windows 2000, select Settings and then Printers.
• For Windows XP/2003, select Printers and Faxes.
• For Windows Vista, select Control Panel > Hardware and Sound > 

Printers.
2. Select your machine.
3. Right-click on the printer driver icon and select Printing Preferences.
4. Change the settings on each tab. 
5. Click OK.

 

Most Windows applications will override settings you specify in the 
printer driver. Change all print settings available in the software 
application first, and change any remaining settings using the printer 
driver. 

SETTING YOUR MACHINE AS A DEFAULT 
MACHINE
1. Click the Windows Start menu.

• For Windows 2000, select Settings > Printers.
• For Windows XP/2003, select Printers and Faxes.
• For Windows Vista, select Control Panel > Hardware and Sound > 

Printers.
2. Select your machine.
3. Right-click your machine and select Set as Default Printer.

PRINTING TO A FILE (PRN)
You will sometimes need to save the print data as a file. 
To create a file:
1. Check the Print to file box at the Print window.

2. Click Print.
3. Type in the destination path and the file name, and then click OK. 

For example c:\Temp\file name.
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 If you type in only the file name, the file is automatically saved in 
My Documents.

MACINTOSH PRINTING
This chapter explains how to print using Macintosh. You need to set the 
print environment before printing. 
• USB connected (See "Macintosh" on page 27.)
• Network connected (See "Macintosh" on page 32.)

Printing a document
When you print with a Macintosh, you need to check the printer driver 
setting in each application you use. Follow the steps below to print from a 
Macintosh:
1. Open an application and select the file you want to print.
2. Open the File menu and click Page Setup (Document Setup in some 

applications).
3. Choose your paper size, orientation, scaling, other options, and make 

sure that your machine is selected. Click OK.

4. Open the File menu and click Print. 
5. Choose the number of copies you want and indicate which pages you 

want to print. 
6. Click Print.

Changing printer settings
You can use advanced printing features when using your machine.
Open an application and select Print from the File menu. The machine 
name, which appears in the printer properties window may differ depending 
on the machine in use. Except for the name, the composition of the printer 
properties window is similar to the following.

 

The setting options may differ depending on printers and Macintosh 
OS version.

Layout
The Layout tab provides options to adjust how the document appears 
on the printed page. You can print multiple pages on one sheet of paper. 

Select Layout from the drop-down list under Orientation to access the 
following features.

• Pages per Sheet : This option determines how many pages to be 
printed on one page. (See "Printing multiple pages on one sheet of 
paper" on page 49.)

• Layout Direction : This option allows you to select the printing 
direction on a page similar to the examples on UI.

• Border : This option allows you to print a border around each page 
on the sheet.

• Two-Sided : This option allows you to print on both sides of a paper. 
(See "Printing on both sides of paper" on page 49.)

• Reverse Page Orientation : This option allows you to rotate paper 
180 degrees. 

Graphics
The Graphics tab provides options for selecting Resolution. Select 
Graphics from the drop-down list under Orientation to access the 
graphic features.

• Resolution (Quality) : This option allows you to select the printing 
resolution. The higher the setting, the sharper the clarity of printed 
characters and graphics. The higher setting also may increase the 
time it takes to print a document.

• Image Mode : This option allows you to enhance printouts. The 
available options are Normal and Text Enhancement.

Paper
Set Paper Type to correspond to the paper loaded in the tray from 
which you want to print. This will let you get the best quality printout. If 
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you load a different type of print material, select the corresponding paper 
type.

Printer Features
Printer Features tab provides Reverse Duplex Printing and Fit to 
Page options. Select Printer Features from the drop-down list under 
Orientation to access the following features:

• Reverse Duplex Printing : This option allows you to select general 
print order compared to duplex print order. If this option does not 
appear, your machine does not have this feature.

• Fit to Page : This option allows you to scale your print job to any 
selected paper size regardless of the document size. This can be 
useful when you want to check fine details on a small document.

Printing multiple pages on one sheet of paper
You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft pages.
1. Open an application, and select Print from the File menu.
2. Select Layout from the drop-down list under Orientation. In the Pages 

per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3. Select the other options you want to use.
4. Click Print, then the machine prints the selected the number of pages 

you want to print on one sheet of paper.

Printing on both sides of paper
You can print on both sides of the paper. Before printing in the duplex mode, 
decide on which edge you will be binding your finished document. The 
binding options are, as follows:
• Long-Edge Binding : This option is the conventional layout used in 

book binding.
• Short-Edge Binding : This option is the type often used with calendars.
1. From your Macintosh application, select Print from the File menu.
2. Select Layout from the drop-down list under Orientation. 
3. Select a binding orientation from Two Sided Printing option.
4. Select the other options you want to use.
5. Click Print, then the machine prints on both sides of the paper.

 

If you print more than 2 copies, the first copy and the second copy 
might print on same sheet of paper. Avoid printing on both sides of 
paper when you are printing more than 1 copy. 

LINUX PRINTING
Printing from applications
There are a lot of Linux applications that allow you to print using Common 
UNIX Printing System (CUPS). You can print on your machine from any 
such application.
1. Open an application, and select Print from the File menu
2. Select Print directly using lpr.
3. In the LPR GUI window, select the model name of your machine from 

the printer list and click Properties.
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4. Change the print job properties using the following four tabs displayed at 
the top of the window.

• General : This option allows you to change the paper size, the paper 
type, and the orientation of the documents. It enables the duplex 
feature, adds start and end banners, and changes the number of 
pages per sheet.

• Text : This option allows you to specify the page margins and set the 
text options, such as spacing or columns.

• Graphics : This option allows you to set image options that are used 
when printing images/files, such as color options, image size, or 
image position.

• Advanced : This option allows you to set the print resolution, paper 
source, and destination.

 

If an option is grayed out, it means that the grayed out option is not 
supported.

5. Click Apply to apply the changes and close the Properties window.
6. Click OK in the LPR GUI window to start printing.
7. The Printing window appears, allowing you to monitor the status of your 

print job.
To abort the current job, click Cancel.

Printing files
You can print many different types of files on your machine using the 
standard CUPS way, directly from the command line interface. The CUPS 
lpr utility allows you to do that. But the drivers package replaces the 
standard lpr tool by a much more user-friendly LPR GUI program.
To print any document file:
1. Type lpr <file_name> from the Linux shell command line and press 

Enter. The LPR GUI window appears.
When you type only lpr and press Enter, the Select file(s) to print 
window appears first. Just select any files you want to print and click 
Open.

2. In the LPR GUI window, select your machine from the list, and change 
the print job properties.

3. Click OK to start printing.

Configuring Printer Properties
Using the Printer Properties window provided by the Printers 
configuration, you can change the various properties for your machine as 
a printer.

1. Open the Unified Driver Configurator.
If necessary, switch to Printers configuration.

2. Select your machine on the available printers list and click Properties.
3. The Printer Properties window opens.

The following five tabs display at the top of the window:
• General : This option allows you to change the printer location and 

name. The name entered in this tab displays on the printer list in 
Printers configuration.

• Connection : This option allows you to view or select another port. If 
you change the machine port from USB to parallel or vice versa 
while in use, you must re-configure the machine port in this tab.

• Driver : Allows you to view or select another printer driver. By 
clicking Options, you can set the default device options.

• Jobs : This option shows the list of print jobs. Click Cancel job to 
cancel the selected job and select the Show completed jobs check 
box to see previous jobs on the job list.

• Classes : This option shows the class that your machine is in. Click 
Add to Class to add your machine to a specific class or click 
Remove from Class to remove the machine from the selected 
class.

4. Click OK to apply the changes and close the Printer Properties 
window.

PRINTING WITH PS DRIVER
PS printer driver is provided on the supplied software CD. 
If you select Typical installation for a local printer or Typical installation 
for a network printer when installing machine’s driver, PS driver will 
automatically be installed. (See "Installing USB connected machine’s driver" 
on page 26 or "Installing network connected machine’s driver" on page 32.)

 

After installing the memory module, you need to select it in the printer 
properties of the PostScript printer driver in order to use it. (See 
"Activating the added accessories in printer properties" on page 78.) 

1. Open the document you want to print.
2. Select Print from the File menu. The Print window appears. It may look 

slightly different depending on your application.
The basic print settings are selected within the Print window. These 
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settings include the number of copies and print range. 

3. Select your machine’s PS driver from the Select Printer list.

 

To take advantage of the printer features provided by your printer 
driver, click Properties or Preferences in the application’s Print 
window to change the print setting. (See "Understanding PS 
driver’s Printing Preferences" on page 51.)

4. To start the print job, click OK or Print in the Print window.

Understanding PS driver’s Printing Preferences
Opening Printing Preferences
1. Open the document you want to print.
2. Select Print from the file menu. The Print window appears. 
3. Select your machine’s PS driver from the Select Printer. 
4. Click Properties or Preferences. 

Layout tab
The Layout tab provides options to adjust how the document appears 
on the printed page. 

Orientation
This option allows you to select the direction in which the information is 
printed on a page. 
• Portrait : This option prints across the width of the page, letter style.

• Landscape : This option prints across the length of the page, 
spreadsheet style.

• Rotate Landscape : This option allows you to rotate the page, 180 
degrees.

Print on Both Sides
You can print on both sides of a sheet of paper. Before printing, decide 
how you want your document oriented.
• None 
• Flip on Long Edge : This option is the conventional layout used in 

bookbinding.

• Flip on Short Edge : This option is the type often used with 
calendars.

 

Do not print on both sides of labels, transparencies, envelopes, 
or thick papers. It may result in paper jam and damage to the 
machine. 

Page Order
This option allows you to select the printout order.
• Front to Back : Pages are printed out in regular order.
• Back to Front : Pages are printed out in reverse order.

Pages Per Sheet
You can select the number of pages to print on a single sheet of paper. 
To print more than one page per sheet, the pages will be reduced in size 
and arranged in the order you specify. You can print up to 16 pages on 
one sheet. 

Advanced
You can select Paper Size, Graphic, and Document Options. 

• Paper/Output : This option allows you to choose paper size you 
want to use.
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• Graphic : This option allows you to select printing quality options.
• Document Options : This option allows you to select options such 

as Post Script Option and, Printer Features. 

Paper/Quality tab
You can select paper tray and media type. 

• Paper Source : This option allows you to choose which tray to use.
• Media : This option allows you to choose which media to use. 
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7.machine status and advanced features
This chapter explains how to browse the current status of your machine, and the method of setting for the advanced 
machine setup. Read this chapter carefully in order to use your machine's diverse features.
This chapter includes:
• Accessing the menu
• Information
• Layout
• Paper

• Graphic
• System setup 
• Emulation
• Network

  

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

ACCESSING THE MENU
1. Press  until the menu you want appears on the bottom line of the 

display and press OK.
2. Press the left/right arrow until the desired menu item appears and press 

OK.
3. If the setting item has sub menus, repeat step 2.
4. Press the left/right arrow to access the required value.
5. Press OK to save the selection.

6. Press  to return to ready mode.

INFORMATION

LAYOUT

• Top Margin : Set the top margin, from 0.0 to 
250mm. 

• Left Margin : Set the left margin, from 0.0 to 
164mm. 

• Long Edge : This item is the conventional 
layout used in bookbinding.

• Short Edge : This item is the conventional 
layout used in calendars.

• Top Margin : Set the top margin, from 0.0 to 
9.9mm. 

• Left Margin : Set the left margin, from 0.0 to 
9.9mm. 

• Short Binding : Set the left margin, from 0.0 
to 22mm. 

• Long Binding : Set the left margin, from 0.0 
to 22mm. 

ITEM DESCRIPTION

Menu Map You can print the menu map which shows the 
layout and current settings of this machine.

Configuration You can print a report on the machine's overall 
configuration.

Demo Page You can print the demo page to check whether 
your machine is printing properly or not.

PCL Font List You can print the PCL font list.

PS3 Font List You can print the PS3 font list.

EPSON Font You can print the EPSON font list.

ITEM DESCRIPTION

Orientation This menu allows you to select the direction in 
which information is printed on a page.

Simplex Margin Set the margin of print materials for one-sided 
printing. You can increase or decrease the value 
in 0.1mm increments.

Duplex To print on both sides of paper, choose the 
binding edge.

Select Off to print on one side of the paper.

Duplex Margin In this menu, you can set the margins for 
double-sided printing. You can increase or 
decrease the value in 0.1mm increments.

ITEM DESCRIPTION
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PAPER

GRAPHIC

• Normal : Doesn’t enhance the quality. 
• Text Enhance : Enhances letters and 

simple figures. 

SYSTEM SETUP

• Off : If a paper mismatch occurs, the 
message will remain on the display and the 
machine will remain off-line until you insert 
the correct paper. 

• On : If the paper mismatch occurs, an error 
message will display. The machine will go 
offline for 30 seconds, then automatically 
clear the message and continue printing. 

• Clean Drum : Cleans the OPC drum of the 
cartridge and produces a sheet with toner 
debris on it. 

• Supplies Life : This item allows you to 
check how many pages are printed and how 
much toner are left in the cartridge. 

• TonerLow Alert : If toner in the cartridge 
has run out, a message informing user to 
change the toner cartridge appears. You can 
set the option for this message to appear or 
not.

• Paper Stacking : If you use a machine in a 
humid area, or you are using the damp print 
media caused by a high humidity, the 
print-outs on the output tray may be curled 
and may not be stacked properly. In this 
case, you can set the machine to use this 
function to let print-outs stacked firmly. But, 
using this function will make the print speed 
slow.

ITEM DESCRIPTION

Copies You can select the amount of copies from 1 to 
999.

Paper Size You can select the paper size currently loaded in 
the tray.

Paper Type You can select the paper type currently loaded 
in the tray.

Paper Source Using this menu, you can set which tray you 
want to use.
• If you select Auto, the machine can 

automatically determine the source. 
• Select MP Tray or Manual Tray to use the 

multi-purpose tray. If you select Manual 
Tray, you need to press  each time you 
print a page and select Manual Feeder for 
Source from your software application. 

• Tray 2 is available only when an optional tray 
2 is installed. 

Tray Chaining When you select any other value except Auto 
from Paper Source and the selected tray is 
empty, you can set the machine to automatically 
print from other trays.
If this menu item is set to Off, the machine does 
not work until you insert paper into the specified 
tray.

ITEM DESCRIPTION

Resolution Specify the number of dots printed per inch (dpi). 
The higher the setting, the sharper printed 
characters and graphics.

Darkness You can lighten or darken the print on the page 
by changing the toner density setting. The 
Normal setting usually produces the best result. 
Use the Light toner density setting to save 
toner.

Image Enhance This menu allows you to enhance the print 
quality.

ITEM DESCRIPTION

Language This menu determines the language of the text 
that appears on the control panel display and 
information printing.

Power Save When the machine does not receive data for an 
extended period of time, power consumption is 
automatically lowered. You can set how long the 
machine waits before going to power save 
mode.

Auto Continue This menu determines whether or not the 
machine continues printing when it detects the 
paper unmatched to your paper setting.

Altitude Adj. You can optimize print quality according to your 
altitude.

Auto CR This menu allows you to append the required 
carriage return to each line feed, which is useful 
to the Unix user or DOS user.

Job Timeout You can set the length of time the printer waits 
before printing the last page of a print job that 
does not end with a command to print the page.

Maintenance This menu allows you to maintain your machine.

Clear Setting This menu allows you to restore the machine’s 
factory default settings. 
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EMULATION

• Typeface : You can select the standard font 
to be used in PCL emulation. PCL1~PCL7's 
interval between letters is fixed, and 
PCL8~PCL45's interval is proportional to the 
font type and font size. You can adjust the 
font size of PCL1~PCL7 using the Pitch 
item, and PCL8~PCL45 can do using Point 
Size item. 

• Symbol : This item selects the symbol set to 
be used in PCL emulation. The symbol is the 
group of numbers, marks, and special signs 
being used when printing letters. Depending 
on the Typeface setting, available symbol 
sets vary.

• Point Size : When you select one between 
PCL8 and PCL45 from the Typeface menu, 
you can determine the font size by setting 
the height of the characters in the font.

• Courier : This item lets you select the 
version of Courier font to use. 

• Pitch : When you select one between PCL1 
and PCL7 from the Typeface menu, you can 
determine the font size by setting the number 
of characters that will print in one horizontal 
inch of type. The default value, 10 is the best 
size.

• Lines : This item allows you to set vertical 
spacing from 5 to 128 lines for the default 
paper size. The default number of lines may 
differ according to the paper size and printing 
orientation.

• Font : You can select the standard font to be 
used in EPSON emulation. 

• Character Set : This item allows you to 
select a character set of the desired 
language.

• Character Tab. : This item selects the 
character set. 

• Pitch : You can determine the font size by 
setting the number of characters that will 
print in one horizontal inch of type.

• LPI : You can set the number of lines printed 
in one vertical inch.

• Auto Wrap : This item determines whether 
or not the machine automatically performs 
line feed when the data overflows the 
printable area of the print material.

NETWORK

• DHCP : The DHCP server allots the IP 
address to you automatically.

• BOOTP : This BOOTP server allots the IP 
address to you automatically.

• Static : You can enter IP address, subnet 
mask, and gateway manually.

ITEM DESCRIPTION

Emulation Type The machine language defines how the 
computer communicates with the machine.
If you select Auto, your machine can change the 
machine language automatically.

Setup PCL
This item sets the PCL emulation configuration. 
You can set the font type, symbol type, lines per 
page, and font size.

PostScript
This item provides you with the Print PS Error 
menu item. You can select whether or not your 
printer prints an error list when a PS error 
occurs. Select On to print PS 3 emulation errors. 
If an error occurs, the job stops processing, the 
error message prints, and the printer deletes all 
the jobs. If this menu is set to Off, the jobs are 
deleted without an indication of the error.

Setup Epson
This item sets the EPSON emulation 
configuration.

ITEMS DESCRIPTION

TCP/IP This menu allows you to manually set the TCP/IP 
addresses or receive the addresses from the 
network.

EtherTalk This menu lets you select whether or not you use 
the EtherTalk protocol. Select On to use the 
protocol. 

Ethernet Speed This menu allows you to select the ethernet 
speed. 

Clear Setting This menu performs a simple reset and restores 
the factory default settings for the network 
configuration. This setting will only take effect after 
you have reset the printer. 

Network Info This menu allows you to print a page showing the 
network parameters you set. 

ITEM DESCRIPTION



Management tools_ 56

8.management tools
This chapter introduces management tools provided to help you make full use of your machine. 
This chapter includes:
• Introducing useful management tools
• Using SyncThru™ Web Service
• Using the Smart Panel program

• Using SetIP program
• Using the Unified Linux Driver Configurator

  

INTRODUCING USEFUL MANAGEMENT TOOLS
The programs below help you to use your machine conveniently.
• "Using SyncThru™ Web Service" on page 56.
• "Using the Smart Panel program" on page 57.
• "Using SetIP program" on page 57.
• "Using the Unified Linux Driver Configurator" on page 58.

USING SYNCTHRU™ WEB SERVICE

 

Your SyncThru™Web Service window that appears in this user’s 
guide may differ depending on the machine in use.

If you have connected your machine to a network and set up TCP/IP 
network parameters correctly, you can manage the machine via 
SyncThru™Web Service, an embedded web server. Use SyncThru™Web 
Service to:
• View the machine’s device information and check its current status.
• Change TCP/IP parameters and set up other network parameters.
• Change printer preference.
• Set the email notifications advising of the machine’s status.
• Get support for using the machine.

To access SyncThru™Web Service:
1. Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.

SyncThru™Web Service overview

• Information tab : This tab gives you general information about your 
machine. You can check things, such as the machine’s IP address, 
remaining amount of toner, ethernet information, firmware version, and 
so on. You can also print reports such as an error report and so on. 

• Machine Settings tab : This tab allows you to set options provided by 
your machine. 

• Network Settings tab : This tab allows you to view and change the 
network environment. You can set things, such as TCP/IP, enabling 
Ether Talk and so on. 

• Maintenance tab : This tab allows you to maintain your machine by 
upgrading firmware and setting security information. 

• Support tab : This tab allows you to set contact information for sending 
email. You can also connect to SEC website or download drivers by 
selecting Link. 

E-mail Notification Setup
You can receive emails about your machine’s status by setting this option. 
1. Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.
3. From the Machine Settings, select E-mail Notification Setup. 
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4. Set required settings. 

5. Click Apply. 

USING THE SMART PANEL PROGRAM
Smart Panel is a program that monitors and informs you of the machine 
status, and allows you to customize the machine’s settings. Smart Panel is 
installed automatically when you install the machine software.

 

To use this program, you need the following system requirements:
• Windows. Check for windows operating system(s) compatible with 

your machine. (See "System requirements" on page 25.)
• Mac OS X 10.3 or higher
• Linux. Check for Linux systems that are compatible with your 

machine. (See "System requirements" on page 25.)
• Internet Explorer version 5.0 or higher for flash animation in HTML 

Help.
If you need to know the exact model name of your machine, you can 
check the supplied software CD.

Understanding Smart Panel
If an error occurs while printing, you can check the error from the Smart 
Panel.
You can also launch Smart Panel manually. Double-click the Smart Panel 
icon on the Windows task bar (in Windows), or Notification Area (in Linux). 
You can also click it on the status bar (in Mac OS X).

Or, if you are a Windows user, you can launch it from the Start menu, select 
Programs or All Programs > your printer driver name > Smart Panel.

 

• If you have already installed more than one Samsung machine, 
first select the correct machine model you want in order to access 
the corresponding Smart Panel.
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart 
Panel icon and select your machine.

• The Smart Panel window and its contents shown in this user’s 

guide may differ depending on the machine or operating system in 
use.

 

1

 

2

 

3  

This button changes to Troubleshooting 
Guide when error occurs. You can directly 
open troubleshooting section in the user’s 
guide. 

 

4
 

If you connect your machine to a network, 
the SyncThru™ Web Service window 
appears instead of the Printer Settings Utility 
window.

 

5

The Smart Panel program displays the current status of the machine, the 
level of toner remaining in the toner cartridge(s), and various other types of 
information. You can also change settings.

Opening the Troubleshooting Guide
Find solutions for problems by using the Troubleshooting Guide. 
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart Panel 
icon and select Troubleshooting Guide.

Changing the Smart Panel Program Settings
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart Panel 
icon and select Options. Select the settings you want from the Options 
window. 

USING SETIP PROGRAM
This program is for the network IP setting using the MAC address which is 
the hardware serial number of the network printer card or interface.
It is especially for the network administrator to set several network IPs at the 
same time. 

 

You can only use the SetIP program when your machine is connected 
to a network. 

Windows Double-click this icon in Windows.

Macintosh Click this icon in Mac OS X.

Linux Click this icon in Linux.

Toner Level View the level of toner remaining in the toner 
cartridge(s). The machine and the number of toner 
cartridge(s) shown in the above window may differ 
depending on the machine in use. Some machines 
do not have this feature.

Buy Now Order replacement toner cartridge(s) online.

User’s Guide View User’s Guide.

Printer 
Setting

Configure various machine settings in the Printer 
Settings Utility window. Some machines do not 
have this feature.

Driver Setting Set all of the machine options you need in the 
Printer Preferences window. This feature is 
available only for Windows. (See "Opening 
Printing Preferences" on page 44.)
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Windows
The following procedure is based on the Windows XP operating system.

Installing the program 
1. Insert the software CD provided with your machine. When the 

software CD runs automatically, close the window.
2. From the Start menu select My Computer and open the X drive. ( X 

represents your CD-ROM drive.)
3. Double click Application > SetIP.
4. Double-click Setup.exe to install this program.
5. Click OK.

If necessary, select a language from the drop-down list..
6. Follow the instructions in the window to complete the installation.

Printing out the machine’s MAC address
1. Make sure that the machine is turned on with paper loaded in the tray.
2. Press  until Network appears on the bottom line of the display and 

press OK.
3. Press the left/right arrow until Network Info. appears and press OK.
4. Press the left/right arrow until Print? appears.
5. Press Yes.

Setting network values
1. Print the machine’s network configuration report to find your machine’s 

MAC address. 
2. From the Windows Start menu, select All Programs > Samsung 

Network Printer Utilities > SetIP > SetIP.
3. Click to open the TCP/IP configuration window. 
4. Enter the network card’s MAC address, IP address, subnet mask, 

default gateway, and then click Apply. 

 

When you enter the MAC address, enter it without a colon(:).

5. The machine prints the network information. Confirm all the settings are 
correct. 

6. Close the SetIP program. 

Macintosh
SetIP program should be automatically installed during the printer driver 
installation.

Printing out the machine’s MAC address
1. Make sure that the machine is turned on with paper loaded in the 

tray.

2. Press  until Network appears on the bottom line of the display 
and press OK.

3. Press the left/right arrow until Network Info. appears and press OK.
4. Press the left/right arrow until Print? appears.
5. Press Yes.

Setting network values
If you want to change your network printer IP setting, follow the below 
instruction.

 

If you select Typical installation for a network printer during the 
printer driver installation, the SetIP program automatically runs 
after the installation. Go to step 4.

1. Print the machine’s network configuration report to find your 
machine’s MAC address. 

2. Open the Library folder > Printers > Samsung > your printer 
model name > SetIP.

3. Double click the SetIPApplet.html file. 
4. The certificate window appears, click Trust. 
5. Click to open the TCP/IP configuration window. 
6. Enter the network card’s MAC address, IP address, subnet mask, 

default gateway, and then click Apply. 

 

When you enter the MAC address, enter it without a colon(:).

7. The machine prints the network information. Confirm all the settings 
are correct. 

8. Close the SetIP program. 

Linux
SetIP program should be automatically installed during the printer driver 
installation.

Printing out the machine’s MAC address
1. Make sure that the machine is turned on with paper loaded in the 

tray.

2. Press  until Network appears on the bottom line of the display 
and press OK.

3. Press the left/right arrow until Network Info. appears and press OK.
4. Press the left/right arrow until Print? appears.
5. Press Yes.

Setting network values
1. Print the machine’s network configuration report to find your 

machine’s MAC address. 
2. Open the /opt/Samsung/mfp/share/utils/.
3. Double click the SetIPApplet.html file. 
4. Click to open the TCP/IP configuration window. 
5. Enter the network card’s MAC address, IP address, subnet mask, 

default gateway, and then click Apply. 

 

When you enter the MAC address, enter it without a colon(:).

6. The machine prints the network information. Confirm all the settings 
are correct. 

7. Close the SetIP program. 

USING THE UNIFIED LINUX DRIVER 
CONFIGURATOR
The supplied software CD provides you with the Unified Linux Driver 
package for using your machine with a Linux computer.
Unified Linux Driver Configurator is a tool primarily intended for configuring 
machine devices.
After the driver is installed on your Linux system, the Unified Linux Driver 
Configurator icon will automatically be created on your desktop.

Opening the Unified Driver Configurator
1. Double-click the Unified Driver Configurator on the desktop.

You can also click the Startup Menu icon and select Samsung Unified 
Driver > Unified Driver Configurator.
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2. Click each button on the left to switch to the corresponding configuration 
window.  

 

 To use the on screen help, click Help.

3. After changing the configurations, click Exit to close the Unified Driver 
Configurator.

Printers Configuration
Printers configuration has the two tabs: Printers and Classes.

Printers tab

 

1
 

2
 

3

View the current system’s printer configuration by clicking on the 
machine icon button on the left side of the Unified Driver Configurator 
window.

The printer control buttons are, as follows:

• Refresh : Renews the available machines list.
• Add Printer : Allows you to add a new machines.
• Remove Printer : Removes the selected machine.
• Set as Default : Sets the current selected machine as a default 

machine.
• Stop/Start : Stops/starts the machine.
• Test : Allows you to print a test page to ensure the machine is 

working properly.
• Properties : Allows you to view and change the printer properties. 

Classes tab

 

1
 

2

The Classes tab shows a list of available machine classes.

• Refresh : Renews the classes list.
• Add Class : Allows you to add a new machine class.
• Remove Class : Removes the selected machine class.

1 Printers 
Configuration 

2 Ports 
Configuration 

Switches to Printers configuration.

Shows all of the installed machine.

Shows the status, model name and URI of your machine.

Shows all of the machine classes.

Shows the status of the class and the number of machines in the 
class.
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Ports configuration

 

1
 

2
 

3

In this window, you can view the list of available ports, check the status of 
each port and release a port that is stalled in a busy state when its owner 
has terminated the job for any reason.

• Refresh : Renews the available ports list.
• Release port : Releases the selected port.

Switches to Ports configuration.

Shows all of the available ports.

Shows the port type, device connected to the port, and status
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9.maintenance
This chapter provides information for maintaining your machine and the toner cartridge.
This chapter includes:
• Printing a machine report
• Monitoring the supplies life
• Using Toner Low Alert

• Cleaning a machine
• Storing the Toner cartridge
• Tips for moving & storing your machine

  

PRINTING A MACHINE REPORT
You can print a configuration page to view current printer settings, or to help 
troubleshoot printer problems. 

1. Press and hold the  on the control panel for about 5 seconds.
A configuration page prints out.

MONITORING THE SUPPLIES LIFE
To view the supply life indicators, follow the steps below:

1. Press  until System Setup appears on the bottom line of the display 
and press OK.

2. Press the left/right arrow until Maintenance appears and press OK.
3. Press the left/right arrow until Supplies Lifer appears and press OK.
4. Press the left/right arrow until the setting you want appears.
5. Press OK to save the selection.

6. Press  to return to ready mode.

USING TONER LOW ALERT
If toner in the cartridge has run out, a message informing user to change the 
toner cartridge appears. You can set the option for this message to appear 
or not. 
1. Ensure that you have installed the printer driver with the provided     

Printer Software CD.
2. Double-click the Smart Panel icon on the Windows task bar (or 

Notification Area in Linux). You can also click Smart Panel on the status 
bar in Mac OS X.

3. Click Printer Setting.
4. Click Setting > Toner Low Alert. Select the appropriate setting and 

then click Apply. 

CLEANING A MACHINE
If printing quality problems occur or if you use your machine in a dusty 
enviroment, you need to clean your machine regularly to keep the best 
printing condition and use your machine longer.

 

• Cleaning the cabinet of the machine with cleaning materials 
containing large amounts of alcohol, solvent, or other strong 
substances can discolor or distort the cabinet. 

• If your machine or the surrounding area is contaminated with 
toner, we recommend you use cloth or tissue dampened with 

water to clean it. If you use a vacuum cleaner, toner blows in the 
air and might be harmful to you.

Cleaning the outside
Clean the machine cabinet with a soft, lint-free cloth. Dampen the cloth 
slightly with water, but be careful not to let any water drip onto or into the 
machine.

Printing a cleaning sheet
If you are experiencing blurred, or smeared printouts, you can clear the 
problem by printing a cleaning sheet, provided by your printer.
You can Print:
• OPC cleaning sheet : cleans the OPC drum of the toner cartridge.
This process will produce a page with toner debris, which should be 
discarded.
1. Make sure that the machine is turned on with paper loaded in the tray.

2. Press  until System Setup appears on the bottom line of the display 
and press OK.

3. Press the left/right arrow until Maintenance appears and press OK.
4. Press the left/right arrow until Clean Drum appears.
5. Press OK

Your machine automatically picks up a sheet of paper from the tray and 
prints out a cleaning sheet with dust or toner particles on it. 

Cleaning the inside
During the printing process, paper, toner, and dust particles can accumulate 
inside the machine. This buildup can cause print quality problems, such as 
toner specks or smearing. Cleaning the inside of the machine clears and 
reduces these problems.
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1. Turn the machine off and unplug the power cord. Wait for the machine to 
cool down.

2. Open the front cover and pull the toner cartridge out. Set it on a clean 
flat surface

 

• To prevent damage to the toner cartridge, do not expose it to 
light for more than a few minutes. Cover it with a piece of 
paper, if necessary. 

• Do not touch the green surface underside of the toner 
cartridge. Use the handle on the cartridge to avoid touching 
this area.

3. With a dry, lint-free cloth, wipe away any dust and spilled toner from the 
toner cartridge area.

 

While cleaning the inside of the machine, be careful not to damage 
the transfer roller or any other inside parts. Do not use solvents 
such as benzene or thinner to clean. Printing quality problems can 
occur and cause damage to the machine.

4. Locate the long strip of glass (LSU) inside the top of the cartridge 
compartment and gently swab the glass to see if dirt turns the white 
cotton black.

5. Reinsert the toner cartridge and close the front cover.
6. Plug in the power cord and turn the machine on.

STORING THE TONER CARTRIDGE
Toner cartridges contain components that are sensitive to light, 
temperature, and humidity. Samsung suggests users follow the 
recommendations to ensure the optimum performance, highest quality, and 
longest life from your new Samsung toner cartridge.
Store this cartridge in the same environment as the printer it will be used in; 
this should be in controlled office temperature and humidity conditions. The 
toner cartridge should remain in its original, unopened package until 
installation – If original packaging is not available, cover the top opening of 
the cartridge with paper and store in a dark cabinet.
Opening the cartridge package prior to use dramatically shortens its useful 
shelf and operating life. Do not store on the floor. If the toner cartridge is 
removed from the printer, always store the cartridge:
• Inside the protective bag from the original package. 
• Correct side up in a horizontal position (not standing on end).
• Do not store consumables in;

- Temperature greater than 40°C (104°F).
- Humidity range less than 20% and not greater than 80%.
- An environment with extreme changes in humidity or temperature.
- Direct sunlight or room light.
- Dusty places.
- A car for a long period of time.
- An environment where corrosive gases are present.
- An environment with salty air.

Handling instructions
• Do not touch the surface of the photosensitive drum in the cartridge.
• Do not expose the cartridge to unnecessary vibrations or shock.
• Never manually rotate the drum, especially in the reverse direction; this 

can cause internal damage and toner spillage.

Use of non-Samsung and refilled toner cartridge
Samsung Electronics does not recommend or approve the use of 
non-Samsung brand toner cartridges in your printer including generic, store 
brand, refilled, or remanufactured toner cartridges.

 

Samsung’s printer warranty does not cover damage to the machine 
caused by the use of a refilled, remanufactured, or non-Samsung 
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brand toner cartridge.

Estimated cartridge life
Estimated cartridge life (the life of the toner cartridge yield) depends on the 
amount of toner that print jobs require. The actual print-out number may 
vary depending on the print density of the pages you print on, operating 
environment, printing interval, media type, and/or media size. For example, 
if you print a lot of graphics, the consumption of the toner is high and you 
may need to change the cartridge more often.

TIPS FOR MOVING & STORING YOUR MACHINE
• When moving the machine, do not tilt or turn it upside down. Otherwise, 

the inside of the machine may be contaminated by toner, which can 
cause damage to the machine or bad print quality.

• When moving the machine, make sure at least two people are holding 
the machine securely. 
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10.troubleshooting
This chapter gives helpful information for what to do if you encounter an error.
This chapter includes:
• Redistributing toner
• Tips for avoiding paper jams
• Clearing paper jams

• Understanding display messages
• Solving other problems

  

REDISTRIBUTING TONER
When the toner cartridge is near the end of its life:
• White streaks or light printing occurs. 
• Toner Low. ReplaceToner appears on the display.
• The Status LED blinks red. 
If this happens, you can temporarily improve print quality by redistributing 
the remaining toner in the cartridge. In some cases, white streaks or light 
printing will still occur even after you have redistributed the toner.
1. Open the front cover.
2. Pull the toner cartridge out.

3. Thoroughly roll the cartridge five or six times to distribute the toner 
evenly inside the cartridge.

 

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

 

Do not touch the green underside of the toner cartridge. Use the 
handle on the cartridge to avoid touching this area. 

4. Hold the toner cartridge by the handle and slowly insert the cartridge into 
the opening in the machine. 
Tabs on the sides of the cartridge and corresponding grooves within the 
machine will guide the cartridge into the correct position until it locks into 

place completely.

5. Close the front cover. Ensure that the cover is securely closed. 

TIPS FOR AVOIDING PAPER CURLS
1. Open the rear cover.
2. Pull down the pressure lever on each side about 30 degrees.

 

Keep the rear cover opened during printing. 
Only use when the printout has more than 20mm curl. 

1 Pressure lever
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TIPS FOR AVOIDING PAPER JAMS
By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, refer to the next guidelines. 
• Ensure that the adjustable guides are positioned correctly. (See 

"Loading paper in the tray" on page 38.)
Do not overload the tray. Ensure that the paper level is below the paper 
capacity mark on the inside of the tray.

• Do not remove paper from the tray while your machine is printing.
• Flex, fan, and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.
• Do not mix paper types in a tray.
• Use only recommended print media. (See "Setting the paper size and 

type" on page 41.)
• Ensure that the recommended side of the print media is facing down in 

the tray, or facing up in the multi-purpose tray.
• If paper jams occur frequently when you print on A5/B5-sized paper: 

Load the paper into the tray with the long edge facing the front of the 
tray. If load the paper this way, printing both sides of the paper (Duplex) 
is not supported.

In the Printing Preferences window, set the page orientation to be 
rotated 90 degrees. (See "Opening Printing Preferences" on page 44.)

CLEARING PAPER JAMS
When a paper jam occurs, a warning message appears on the display. 

 

To avoid tearing the paper, pull the jammed paper out slowly and 
gently. Follow the instructions in the following sections to clear the 
jam. 

In tray 1
1. Open and close the front cover. The jammed paper is automatically 

ejected from the machine.
If the paper does not exit, go to the next step.

2. Pull out tray 1 .

3. Remove the jammed paper by gently pulling it straight out.

If the paper does not move when you pull, or if you do not see the paper 
in this area, check the fuser area around the toner cartridge. (See 
"Inside the machine" on page 66.)

4. Insert tray 1 back into the machine until it snaps into place. Printing 
automatically resumes.

In optional tray 2
1. Pull out optional tray 2.
2. Remove the jammed paper from the machine.

If the paper does not move when you pull or if you do not see the paper 
in this area, stop and go to the next step.

3. Pull tray 1 half-way out.
4. Pull the paper straight up and out.

5. Insert the trays back into the machine. Printing automatically resumes.
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In the multi-purpose tray
1. If the paper is not feeding properly, pull the paper out of the machine.

2. Open and close the front cover to resume printing.

Inside the machine

 

The fuser area is hot. Take care when removing paper from the 
machine.

1. Open the front cover and pull the toner cartridge out, lightly pushing it 
down.

2. Remove the jammed paper by gently pulling it straight out.

3. Replace the toner cartridge and close the front cover. Printing 
automatically resumes.

In exit area
1. Open and close the front cover. The jammed paper is automatically 

ejected from the machine.
If you do not see the jammed paper, go to next step.

2. Gently pull the paper out of the output tray.

If you do not see the jammed paper or if there is any resistance when 
you pull, stop and go to the next step.

3. Open the rear cover.
4. Pull down the pressure lever on each side about 90 degrees.
5. Pull the fuser door down and remove the paper. 

Return the fuser door and the pressure levers to their original position.

1

6. Close the rear cover. Printing automatically resumes.

In the duplex unit area 
If the duplex unit is not inserted correctly, a paper jam may occur. Make 
sure that the duplex unit is inserted correctly.
1. Pull the duplex unit out of the machine.

1 fuser door
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2. Remove the jammed paper from the duplex unit.

If the paper does not come out with the duplex unit, remove the paper 
from the bottom of the machine. 
Insert the duplex unit into the machine.

If you still do not see the paper, go to the next step.
3. Open the rear cover.
4. Pull down the pressure lever on each side about 90 degrees.
5. Pull the fuser door down and remove the paper. 

Return the fuser door and the lever to their original position.

1

6. Close the rear cover. Printing automatically resumes.

UNDERSTANDING DISPLAY MESSAGES
Messages appear on the control panel display to indicate the machine’s 
status or errors. Refer to the tables below to understand the messages’ and 
their meaning, and correct the problem, if necessary. 

 

• If a message is not in the table, reboot the power and try the 
printing job again. If the problem persists, call for service.

• When you call for service, provide the service representative with 
the contents of display message.

• Some messages may not appear in the display depending on 
options or models.

1 fuser door

MESSAGE MEANING SUGGESTED 
SOLUTIONS

Paper Jam 0
Open/Close Door

Paper has jammed in 
the paper feed area. 
(tray 1, optional tray2, 
multi-purpose tray) 

Clear the jam. (See "In 
tray 1" on page 65, "In 
optional tray 2" on 
page 65, "In the 
multi-purpose tray" on 
page 66.)

 

If paper jam 
occurs in MP tray 
while printing on a 
transparency, 
load the 
transparency in 
tray1 and try 
printing again. 

Paper Jam 1
Open/Close Door

Paper has jammed 
around the toner 
cartridge.

Clear the jam. (See 
"Inside the machine" on 
page 66.)

Paper Jam 2
Check Inside

Paper has jammed in 
the paper exit area.

Clear the jam. (See "In 
exit area" on page 66.)

Duplex Jam 0
Check Inside

Paper has jammed in 
the duplex area.

Clear the jam. (See "In 
the duplex unit area" on 
page 66.)

Duplex Jam 1
Open/Close Door

Paper has jammed in 
the duplex area.

Clear the jam. (See "In 
the duplex unit area" on 
page 66.)

Door Open The front cover or rear 
cover is not securely 
latched.

Close the cover until it 
locks into place. 

Fuser Door Open The fuser door is not 
securely latched. 

Open the rear cover 
and close the fuser door 
until it locks into place. 
Fuser door location. 
(See "In exit area" on 
page 66.)

Load Manually 
Press Stop Key

Manual Feeder mode 
is selected in the 
Printing 
Preferences. 

Load a sheet of print 
material and press . 
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IP Conflict The network IP 
address you have set 
is being used by 
someone else. 

Check the IP address 
and reset it if 
necessary. (See 
"Setting the network 
address" on page 31.)

Low Heat Error
Cycle Power

There is a problem in 
the fuser unit. 

Unplug the power cord 
and plug it back in. If the 
problem persists, 
please call for service. 

LSU Hsync Error
Cycle Power

A problem has 
occurred in the LSU 
(Laser Scanning Unit 
).

Unplug the power cord 
and plug it back in. If the 
problem persists, 
please call for service. 

LSU Motor Error
Cycle Power

A problem has 
occurred in the LSU 
(Laser Scanning Unit. 
)

Unplug the power cord 
and plug it back in. If the 
problem persists, 
please call for service. 

Main Motor Locked There is a problem in 
the main motor. 

Open and then close 
the front cover. 

Open Heat Error
Cycle Power

There is a problem in 
the fuser unit. 

Unplug the power cord 
and plug it back in. If the 
problem persists, 
please call for service. 

Self Diagnostics
Temperature

The engine in your 
printer is checking 
some problems 
detected. 

Please wait a few 
minutes.

Self Diagnostics
LSU

The engine in your 
printer is checking 
some problems 
detected. 

Please wait a few 
minutes.

Tray 1
Paper Empty

There is no paper in 
the tray 1. 

Load paper in the tray 1. 
(See "Tray 1 / optional 
tray" on page 38.)

Tray 2
Paper Empty

There is no paper in 
the optional tray 2. 

Load paper in the 
optional tray 2. (See 
"Tray 1 / optional tray" 
on page 38.)

Install Toner A toner cartridge is 
not installed

Install a toner cartridge

Invalid Toner The toner cartridge 
you have installed is 
not for your printer.

Install a 
Samsung-genuine toner 
cartridge, designed for 
your printer.

MESSAGE MEANING SUGGESTED 
SOLUTIONS

Non Genuine Toner 
◄Stop►

The toner cartridge 
installed is not a 
genuine cartridge.

You can select either 
Stop or Continue. If 
you do not select any, 
the printer will work as 
Stop is selected.
If you select Stop, you 
cannot print until the 
genuine cartridge is 
installed. However, you 
can still print any kind of 
reports.
If you select Continue, 
you can keep printing 
but the quality cannot 
be guaranteed, and the 
product support is no 
longer provided.
If you want to change 
the selection, turn the 
printer off and on to 
have this message 
appear again, and then 
re-select Stop or 
Continue.

NonGenuine Toner 
Replace Toner1

The toner cartridge 
installed is not a 
genuine cartridge.

This message appears 
when you selected Stop 
at the NonGenuine 
Toner prompt.
Install the genuine toner 
cartridge.

NonGenuine Toner 
Replace Toner

The toner cartridge 
installed is not a 
genuine cartridge.

This message appears 
when you selected 
Continue at the 
NonGenuine Toner 
prompt.
Install the genuine toner 
cartridge.

Toner Low
Replace Toner

Small amount of toner 
is left in the cartridge. 
The estimated 
cartridge life of toner 
is close.

 

If you do not 
want this 
message to 
appear, see 
"Using Toner 
Low Alert" on 
page 61.

Prepare a new cartridge 
for replacement. You 
may temporarily 
increase the printing 
quality by redistributing 
the toner. (See 
"Redistributing toner" 
on page 64.)

MESSAGE MEANING SUGGESTED 
SOLUTIONS
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Replace Toner A toner cartridge has 
almost reached its 
estimated cartridge 
life.

Replace the toner 
cartridge for the best 
print quality when this 
message appears. 
Using a cartridge 
beyond this stage can 
result in printing quality 
issues. (See "Replacing 
the toner cartridge" on 
page 78.)

 

Samsung does 
not recommend 
using 
non-genuine 
Samsung toner 
cartridge such as 
refilled or 
remanufactured. 
Samsung cannot 
guarantee 
non-genuine 
Samsung toner 
cartridge's quality. 
Service or repair 
required as a 
result of using 
non-genuine 
Samsung toner 
cartridges will not 
be covered under 
the machine 
warranty.

MESSAGE MEANING SUGGESTED 
SOLUTIONS

Toner Exhausted A toner cartridge has 
reached its estimated 
cartridge life. The 
printer stops printing.

 

Estimated 
cartridge life 
means the 
expected or 
estimated toner 
cartridge life, 
which indicates 
the average 
capacity of 
print-outs and is 
designed 
pursuant to 
ISO/IEC 19752. 
(See "General 
specifications" 
on page 80.) 
The number of 
pages may be 
affected by 
operating 
environment, 
printing interval, 
media type, and 
media size. 
Some amount of 
toner may 
remain in the 
cartridge even 
when Toner 
Exhausted 
appears and the 
printer stops 
printing.

Replace the toner 
cartridge. (See 
"Replacing the toner 
cartridge" on page 78.)

Out-Bin Full The output tray is full. Remove papers from 
the output tray, the 
printer resumes 
printing. 

MESSAGE MEANING SUGGESTED 
SOLUTIONS
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SOLVING OTHER PROBLEMS
The following chart lists some conditions that may occur and the 
recommended solutions. Follow the suggested solutions until the problem is 
corrected. If the problem persists, call for service.

Paper feeding problems

Printing problems

CONDITION SUGGESTED SOLUTIONS

Paper jams during 
printing.

Clear the paper jam. (See "Clearing paper jams" 
on page 65.)

Paper sticks 
together.

• Check the maximum paper capacity of the 
tray. (See "Print media specifications" on 
page 82.)

• Make sure that you are using the correct type 
of paper. (See "Print media specifications" on 
page 82.)

• Remove paper from the tray and flex or fan 
the paper.

• Humid conditions may cause some paper to 
stick together.

Multiple sheets of 
paper do not feed.

Different types of paper may be stacked in the 
tray. Load paper of only one type, size, and 
weight.

Paper does not feed 
into the machine.

• Remove any obstructions from inside the 
machine.

• Paper has not been loaded correctly. Remove 
paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• The paper is too thick. Use only paper that 
meets the specifications required by the 
machine. (See "Print media specifications" on 
page 82.)

The paper keeps 
jamming.

• There is too much paper in the tray. Remove 
excess paper from the tray. If you are printing 
on special materials, use the multi-purpose 
tray.

• An incorrect type of paper is being used. Use 
only paper that meets the specifications 
required by the machine. (See "Print media 
specifications" on page 82.)

• There may be debris inside the machine. 
Open the front cover and remove any debris.

Transparencies stick 
together in the paper 
exit.

Use only transparencies specifically designed 
for laser printers. Remove each transparency as 
it exits from the machine.

Envelopes skew or 
fail to feed correctly.

Ensure that the paper guides are against both 
sides of the envelopes.

CONDITION POSSIBLE 
CAUSE

SUGGESTED 
SOLUTIONS

The machine 
does not print.

The machine is not 
receiving power.

Check the power cord 
connections. Check the 
power switch and the power 
source.

The machine is not 
selected as the 
default machine.

Select your machine as your 
default machine in your 
Windows.

Check the machine for the following:
• The front cover is not closed. Close the front 

cover.
• Paper is jammed. Clear the paper jam. (See 

"Clearing paper jams" on page 65.)
• No paper is loaded. Load paper. (See "Loading 

paper in the tray" on page 38.)
• The toner cartridge is not installed. Install the 

toner cartridge.
If a system error occurs, contact your service 
representative.

The connection 
cable between the 
computer and the 
machine is not 
connected properly.

Disconnect the machine 
cable and reconnect it.

The connection 
cable between the 
computer and the 
machine is 
defective.

If possible, attach the cable 
to another computer that is 
working properly and print a 
job. You can also try using a 
different machine cable.

The port setting is 
incorrect.

Check the Windows printer 
setting to make sure that the 
print job is sent to the correct 
port. If the computer has 
more than one port, make 
sure that the machine is 
attached to the correct one.

The machine may 
be configured 
incorrectly. 

Check the Printing 
Preferences to ensure that 
all of the print settings are 
correct. . (See "Opening 
Printing Preferences" on 
page 44.)

The printer driver 
may be incorrectly 
installed.

Repair the machine 
software. (See "Installing 
USB connected machine’s 
driver" on page 26, 
"Installing network 
connected machine’s driver" 
on page 32.)

The machine is 
malfunctioning.

Check the display message 
on the control panel to see if 
the machine is indicating a 
system error. Contact a 
service representative.
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The machine 
does not print. 

The document size 
is so big that the 
hard disk space of 
the computer is 
insufficient to 
access the print job.

Get more hard disk space 
and print the document 
again.

The machine 
selects print 
materials from 
the wrong paper 
source.

The paper option 
that was selected in 
the Printing 
Preferences may 
be incorrect.

For many software 
applications, the paper 
source selection is found 
under the Paper tab within 
the Printing Preferences. 
Select the correct paper 
source. See the printer 
driver help screen. (See 
"Opening Printing 
Preferences" on page 44.)

A print job is 
extremely slow.

The job may be 
very complex.

Reduce the complexity of 
the page or try adjusting the 
print quality settings.

Half the page is 
blank.

The page 
orientation setting 
may be incorrect.

Change the page orientation 
in your application. See the 
printer driver help screen.

The paper size and 
the paper size 
settings do not 
match.

Ensure that the paper size in 
the printer driver settings 
matches the paper in the 
tray.
Or, ensure that the paper 
size in the printer driver 
settings matches the paper 
selection in the software 
application settings you use.

CONDITION POSSIBLE 
CAUSE

SUGGESTED 
SOLUTIONS

The machine 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

The machine cable 
is loose or 
defective.

Disconnect the machine 
cable and reconnect. Try a 
print job that you have 
already printed successfully. 
If possible, attach the cable 
and the machine to another 
computer that you know 
works and try a print job. 
Finally, try a new machine 
cable.

The wrong printer 
driver was selected.

Check the application’s 
printer selection menu to 
ensure that your machine is 
selected.

The software 
application is 
malfunctioning.

Try printing a job from 
another application.

The operating 
system is 
malfunctioning.

Exit Windows and reboot the 
computer. Turn the machine 
off and back on again.

If you are in a DOS 
environment, the 
font setting for your 
machine may be 
set incorrectly.

See "Changing font setting" 
on page 36.

Pages print, but 
they are blank.

The toner cartridge 
is defective or out of 
toner.

Redistribute the toner, if 
necessary. 
If necessary, replace the 
toner cartridge.

The file may have 
blank pages.

Check the file to ensure that 
it does not contain blank 
pages.

Some parts, such 
as the controller or 
the board, may be 
defective.

Contact a service 
representative.

The machine 
does not print 
PDF file correctly. 
Some parts of 
graphics, text, or 
illustrations are 
missing.

Incompatibility 
between the PDF 
file and the Acrobat 
products.

Printing the PDF file as an 
image may enable the file to 
print. Turn on Print As 
Image from the Acrobat 
printing options. 

 

It will take longer to 
print when you print a 
PDF file as an image.

CONDITION POSSIBLE 
CAUSE

SUGGESTED 
SOLUTIONS
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, 
there might be a reduction in print quality. See the table below to clear the 
problem. The print quality 

of photos is not 
good. Images are 
not clear.

The resolution of 
the photo is very 
low. 

Reduce the photo size. If 
you increase the photo size 
in the software application, 
the resolution will be 
reduced. 

Before printing, 
the machine 
emits vapor near 
the output tray.

Using damp paper 
can cause vapor 
during printing.

This is not a problem. Just 
keep printing.

The machine 
does not print 
special- sized 
paper, such as 
billing paper.

Paper size and 
paper size setting 
do not match.

Set the correct paper size in 
the Custom in the Paper tab 
in the Printing Preferences. 
(See "Opening Printing 
Preferences" on page 44.)

CONDITION POSSIBLE 
CAUSE

SUGGESTED 
SOLUTIONS

CONDITION SUGGESTED SOLUTIONS

Light or faded print

A aB bC c
A aB bC c
A aB bC c
A aB bC c
A aB bC c

• If a vertical white streak or faded area 
appears on the page, the toner supply is low. 
You may be able to temporarily extend the 
toner cartridge life. (See "Redistributing toner" 
on page 64.) If this does not improve the print 
quality, install a new toner cart

• The paper may not meet paper specifications; 
for example, the paper may be too moist or 
rough. (See "Print media specifications" on 
page 82.)

• If the entire page is light, the print resolution 
setting is too low or the toner save mode is 
on. Adjust the print resolution and turn the 
toner save mode off. See the help screen of 
the printer driver.

• A combination of faded or smeared defects 
may indicate that the toner cartridge needs 
cleaning. (See "Cleaning the inside" on 
page 61.)

• The surface of the LSU part inside the 
machine may be dirty. (See "Cleaning the 
inside" on page 61.)

Toner specks

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C

• The paper may not meet specifications; for 
example, the paper may be too moist or 
rough. (See "Print media specifications" on 
page 82.)

• The transfer roller may be dirty. Clean the 
inside of your machine. Contact a service 
representative.

• The paper path may need cleaning. Contact a 
service representative.

Dropouts If faded areas, generally rounded, occur 
randomly on the page:
• A single sheet of paper may be defective. 

Try reprinting the job.
• The moisture content of the paper is uneven 

or the paper has moist spots on its surface. 
Try a different brand of paper. (See "Print 
media specifications" on page 82.)

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go 
to Printing Preferences, click Paper tab, 
and set type to Thick. (See "Opening 
Printing Preferences" on page 44.)

• If these steps do not correct the problem, 
contact a service representative.
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White Spots If white spots appear on the page:
• The paper is too rough and a lot of dirt from a 

paper falls to the inner devices within the 
machine, so the transfer roller may be dirty. 
Clean the inside of your machine. (See 
"Cleaning the inside" on page 61.).

• The paper path may need cleaning. (See 
"Cleaning the inside" on page 61.)

Vertical lines If black vertical streaks appear on the page:
• The surface (drum part) of the toner 

cartridge inside the machine has probably 
been scratched. Remove the toner cartridge 
and install a new one. (See "Replacing the 
toner cartridge" on page 78.)

If white vertical streaks appear on the page:
• The surface of the LSU part inside the 

machine may be dirty. (See "Cleaning the 
inside" on page 61.)

Color or Black 
background

If the amount of background shading becomes 
unacceptable:
• Change to a lighter weight paper. (See "Print 

media specifications" on page 82.)
• Check the environmental conditions: very 

dry conditions or a high level of humidity 
(higher than 80% RH) can increase the 
amount of background shading.

• Remove the old toner cartridge and, install a 
new one. (See "Replacing the toner 
cartridge" on page 78.)

Toner smear If toner smears on the page: 
• Clean the inside of the machine. (See 

"Cleaning the inside" on page 61.)
• Check the paper type and quality. (See "Print 

media specifications" on page 82.)
• Remove the toner cartridge and then, install 

a new one. (See "Replacing the toner 
cartridge" on page 78.)

Vertical repetitive 
defects

A

If marks repeatedly appear on the printed side of 
the page at even intervals:
• The toner cartridge may be damaged. If you 

still have the same problem, remove the 
toner cartridge and, install a new one. (See 
"Replacing the toner cartridge" on page 78.)

• Parts of the machine may have toner on 
them. If the defects occur on the back of the 
page, the problem will likely correct itself 
after a few more pages.

• The fusing assembly may be damaged. 
Contact a service representative.

CONDITION SUGGESTED SOLUTIONS

Background 
scatter

Background scatter results from bits of toner 
randomly distributed on the printed page. 
• The paper may be too damp. Try printing 

with a different batch of paper. Do not open 
packages of paper until necessary so that 
the paper does not absorb too much 
moisture.

• If background scatter occurs on an envelope, 
change the printing layout to avoid printing 
over areas that have overlapping seams on 
the reverse side. Printing on seams can 
cause problems.

• If background scatter covers the entire 
surface area of a printed page, adjust the 
print resolution through your software 
application or in Printing Preferences. (See 
"Opening Printing Preferences" on page 44.)

Misformed 
characters

A a B b CA a B b CA a B b CA a B b C cA a B b C c

• If characters are improperly formed and 
producing hollow images, the paper stock 
may be too slick. Try different paper. (See 
"Print media specifications" on page 82.)

Page skew • Ensure that the paper is loaded properly.
• Check the paper type and quality. (See "Print 

media specifications" on page 82.)
• Ensure that the guides are not too tight or too 

loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper 
curl. (See "Print media specifications" on 
page 82.)

• Turn the stack of paper over in the tray. Also 
try rotating the paper 180° in the tray.

CONDITION SUGGESTED SOLUTIONS
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Common PostScript problems
The following situations are PS language specific and may occur when 
several printer languages are used.

Wrinkles or 
creases

A

• Ensure that the paper is loaded properly.
• Check the paper type and quality. (See "Print 

media specifications" on page 82.)
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray.

Back of printouts 
are dirty

Check for leaking toner. Clean the inside of the 
machine. (See "Cleaning the inside" on 
page 61.)

Solid Color or 
Black pages

• The toner cartridge may not be installed 
properly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. 
Remove the toner cartridge and install a new 
one. (See "Replacing the toner cartridge" on 
page 78.)

• The machine may require repair. Contact a 
service representative.

Loose toner

A

• Clean the inside of the machine. (See 
"Cleaning the inside" on page 61.)

• Check the paper type and quality. (See "Print 
media specifications" on page 82.)

• Remove the toner cartridge and then, install a 
new one. (See "Replacing the toner cartridge" 
on page 78.)

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Character Voids

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C

Character voids are white areas within parts of 
characters that should be solid black:
• If you are using transparencies, try another 

type of transparency. Because of the 
composition of transparencies, some 
character voids are normal. 

• You may be printing on the wrong surface of 
the paper. Remove the paper and turn it 
around. 

• The paper may not meet paper 
specifications. (See "Print media 
specifications" on page 82.)

CONDITION SUGGESTED SOLUTIONS

Horizontal stripes If horizontally aligned black streaks or smears 
appear:
• The toner cartridge may be installed 

improperly. Remove the cartridge and 
reinsert it.

• The toner cartridge may be defective. 
Remove the toner cartridge and install a new 
one. (See "Replacing the toner cartridge" on 
page 78.)

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Curl If the printed paper is curled or paper does not 
feed into the machine:
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray. 
• Change the printer option and try again. Go 

to Printing Preferences, click Paper tab, 
and set type to Thin. (See "Opening Printing 
Preferences" on page 44.)

• Use the Paper Stacking function. (See 
"Stacking papers firmly" on page 42.)

An unknown image 
repetitively 
appears on a few 
sheets or loose 
toner, light print, or 
contamination 
occurs.

Your machine is probably being used at an 
altitude of 1,000 m (3,281 ft) or above.
The high altitude may affect the print quality, 
such as loose toner or light imaging. Change the 
correct altitude setting to your machine. (See 
"Altitude adjustment" on page 35.)

CONDITION SUGGESTED SOLUTIONS
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Common Windows problems

 

Refer to Microsoft Windows 2000/XP/2003/Vista User’s Guide that 
came with your computer for further information on Windows error 
messages.

Common Linux problems

 

Refer to Linux User’s Guide that came with your computer for further 
information on Linux error messages.

PROBLEM POSSIBLE 
CAUSE SOLUTION

PostScript file 
cannot be printed.

The PostScript 
driver may not be 
installed correctly.

• Install the PostScript 
driver. (See "Installing 
USB connected 
machine’s driver" on 
page 26, "Installing 
network connected 
machine’s driver" on 
page 32.)

• Print a configuration 
page and verify that 
the PS version is 
available for printing.

• If the problem persists, 
contact a service 
representative.

Limit Check Error 
report prints.

The print job was 
too complex.

You might need to 
reduce the complexity of 
the page or install more 
memory. (See "Installing 
a memory module" on 
page 79.)

A PostScript error 
page prints.

The print job may 
not be PostScript.

Make sure that the print 
job is a PostScript job. 
Check to see whether 
the software application 
expected a setup or 
PostScript header file to 
be sent to the machine.

The optional tray is 
not selected in the 
driver.

The printer driver 
has not been 
configured to 
recognize the 
optional tray.

Open the PostScript 
driver properties, select 
the Device Settings tab, 
and set the tray option of 
the Installable Options 
section to Installed.

CONDITION SUGGESTED SOLUTIONS

“File in Use” 
message appears 
during installation.

Exit all software applications. Remove all 
software from the startup group, then restart 
Windows. Reinstall the printer driver.

“General Protection 
Fault”, “Exception 
OE”, “Spool 32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows 
and try printing again.

“Fail To Print”, “A 
printer timeout error 
occurred” messages 
appear.

These messages may appear during printing. 
Just keep waiting until the machine finishes 
printing. If the message appears in ready mode 
or after printing has been completed, check the 
connection and/or whether an error has 
occurred.

CONDITION SUGGESTED SOLUTIONS

The machine does 
not print.

• Check if the printer driver is installed in your 
system. Open Unified Driver Configurator and 
switch to the Printers tab in Printers 
configuration window to look at the list of 
available machines. Make sure that your 
machine is displayed on the list. If not, open 
Add new printer wizard to set up your 
device.

• Check if the machine is started. Open 
Printers configuration and select your 
machine on the printers list. Look at the 
description in the Selected printer pane. If its 
status contains Stopped string, press the 
Start button. After that normal operation of 
the machine should be restored. The 
“stopped” status might be activated when 
some problems in printing occurred. 

• Check if your application has special print 
option such as “-oraw”. If “-oraw” is specified 
in the command line parameter, then remove 
it to print properly. For Gimp front-end, select 
“print” -> “Setup printer” and edit command 
line parameter in the command item.

The machine does 
not print whole 
pages, and output is 
printed on half the 
page.

It is a known problem that occurs when a color 
machine is used on version 8.51 or earlier of 
Ghostscript, 64-bit Linux OS, and has been 
reported to bugs.ghostscript.com as Ghostscript 
Bug 688252.The problem is solved in AFPL 
Ghostscript v. 8.52 or above. Download the 
latest version of AFPL Ghostscript from 
http://sourceforge.net/projects/ghostscript/ and 
install it to solve this problem.

I encounter error 
“Cannot open port 
device file” when 
printing a document.

Avoid changing print job parameters (via LPR 
GUI, for example) while a print job is in progress. 
Known versions of CUPS server break the print 
job whenever print options are changed and 
then try to restart the job from the beginning. 
Since Unified Linux Driver locks the port while 
printing, the abrupt termination of the driver 
keeps the port locked and unavailable for 
subsequent print jobs. If this situation occurs, try 
to release the port by selecting Release port in 
Port configuration window.
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Common Macintosh problems

 

It will take longer to print when you print a 
PDF file as an image.

 

Refer to Macintosh User’s Guide that came with your computer for 
further information on Macintosh error messages.

CONDITION SUGGESTED SOLUTIONS

The machine does 
not print PDF files 
correctly. Some 
parts of graphics, 
text, or illustrations 
are missing.

Printing the PDF file as an image may enable 
the file to print. Turn on Print As Image from the 
Acrobat printing options. 

The document has 
printed, but the print 
job has not 
disappeared from 
the spooler in Mac 
OS X10.3.2.

Update your MAC OS to OS MAC OS X 10.3.3. 
or higher.

Some letters are not 
displayed normally 
during the Cover 
page printing.

Mac OS cannot create the font during the Cover 
page printing. The English alphabet and 
numbers are displayed normally on the Cover 
page.

When printing a 
document in 
Macintosh with 
Acrobat Reader 6.0 
or higher, colors 
print incorrectly.

Make sure that the resolution setting in your 
machine driver matches the one in Acrobat 
Reader.



Supplies and accessories_ 77

11.supplies and accessories
This chapter provides information on purchasing supplies, accessories and maintenance parts available for your machine.
This chapter includes:
• How to purchase
• Available supplies
• Available accessories
• Available maintenance Parts

• Replacing the toner cartridge
• Necessary Precautions to take when installing accessories
• Activating the added accessories in printer properties
• Upgrading a memory module

  

 

Available accessories may differ from country to country. Contact your 
sales representatives to obtain the list of available accessories.

HOW TO PURCHASE
To order Samsung-authorized supplies, accessories and, maintenance 
parts, contact your local Samsung dealer or the retailer where you 
purchased your machine. You can also visit www.samsung.com/supplies, 
select your country/region, and obtain information on calling for service.

AVAILABLE SUPPLIES
When supplies reach their lifespan, you can order the following types of 
supplies for your machine:

To replace a toner cartridge: (See "Replacing the toner cartridge" on 
page 78.)

 

Depending on the options and job mode used, the toner cartridge’s 
lifespan may differ.

 

You must purchase supplies, including toner cartridges, in the same 
country where you  purchased your machine. Otherwise, supplies will 
be incompatible with your machine since the system configuration of 
these vary from country to country.

AVAILABLE ACCESSORIES
You can purchase and install accessories to enhance your machine’s 
performance and capacity.

AVAILABLE MAINTENANCE PARTS
To avoid print quality and paper feed problems resulting from worn parts 
and to maintain your machine in top working condition, the following parts 
will need to be replaced after printing the specified number of pages or 
when the life span of each item has expired.

To purchase maintenance parts, contact the source where you bought the 
machine. 
Replacing maintenance parts can be performed only by an authorized 
service provider, dealer, or the retailer where you bought the machine. The 
warranty does not cover the replacement of any maintenance parts after 
their lifespan.

TYPE AVERAGE YIELDa

a.Declared yield value in accordance with ISO/IEC 19752.

PART NAME

Standard yield 
toner cartridge

Approx. 2,000 pages • MLT-D209S
• Region Ab: 

MLT-D2092S

b.Region A: Albania, Austria, Belgium, Bosnia, Bulgaria, Croatia, Cyprus, 
Czech Republic, Denmark, Finland, France, Germany, Greece, 
Hungary, Italy, Macedonia, Netherlands, Norway, Poland, Portugal, 
Romania, Serbia, Slovakia, Slovenia, Spain, Sweden, Switzerland, UK. 

High yield 
toner cartridge

Approx. 5,000 pages • MLT-D209L
• Region Ab: 

MLT-D2092L

ACCESSORY FUNCTION PART NAME

Memory module Extend your 
machine’s memory 
capacity.

CLP-MEM301: 128 MB

Optional tray 2 If you are 
experiencing 
frequent paper 
supply problems, 
you can attach an 
additional 250 sheet 
tray. You can print 
documents in 
various sizes and 
types of print 
materials.

ML-S2850A

PARTS AVERAGE YIELDa

a. It will be affected by operating system used, computing performance, 
application software, connecting method, media type, media size and 
job complexity.

PART NAME

Transfer roller Approx. 50,000 pages ROLLER-TRANSF
ER

Fuser unit Approx. 50,000 pages ELA UNIT-FUSER

Pickup roller Approx. 50,000 pages ROLLER-PICK UP

http://www.samsung.com/supplies
http://www.samsung.com/supplies
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REPLACING THE TONER CARTRIDGE
When the toner cartridge is empty:
• A message informing user to change the toner cartridge appears on the 

display. 
• The machine stops printing.
At this stage, the toner cartridge needs to be replaced. Check the type of the 
toner cartridge for your machine. (See "Available supplies" on page 77.)
1. Open the front cover.
2. Pull the toner cartridge out.

3. Remove the new toner cartridge from its bag. 

4. Slowly shake the cartridge five or six times to distribute the toner evenly 
inside the cartridge. It will assure maximum copies per cartridge. 

 

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

 

Do not touch the green underside of the toner cartridge. Use the 
handle on the cartridge to avoid touching this area. 

5. Remove the paper protecting the toner cartridge by pulling the packing 
tape. 

6. Hold the toner cartridge by the handle and slowly insert the cartridge into 
the opening in the machine. 
Tabs on the sides of the cartridge and corresponding grooves within the 
machine will guide the cartridge into the correct position until it locks into 

place completely.

7. Close the front cover. Make sure that the cover is securely closed. 

NECESSARY PRECAUTIONS TO TAKE WHEN 
INSTALLING ACCESSORIES
• Disconnect the power cord.

Never remove the control board cover while the power is turned on.
To avoid the possibility of an electrical shock, always disconnect the 
power cord when installing or removing ANY internal or external 
accessories.

• Discharge static electricity.
The control board and internal accessories (network interface card or 
memory module) are sensitive to static electricity. Before installing or 
removing any internal accessories, discharge static electricity from your 
body by touching something metal, such as the metal back plate on any 
device plugged into a grounded power source. If you walk around before 
finishing the installation, repeat this procedure to discharge any static 
electricity again.

• Activating the added accessories in the PS driver properties. After 
installing an accessory such as an optional tray, PS driver users must do 
the additional setting. Go to the PS printer properties and set the added 
accessory activated. 

 

When installing accessories, the battery inside the machine is a 
service component. Do not change it by yourself.
There is a risk of an explosion if battery is replaced by an incorrect 
type. Dispose used batteries according to the instructions.

ACTIVATING THE ADDED ACCESSORIES IN 
PRINTER PROPERTIES
After installing added accessories, you need to select it in the printer 
properties of the printer driver in order to use it.
1. Install the driver. (See "Installing USB connected machine’s driver" on 

page 26, "Installing network connected machine’s driver" on page 32.)
2. Click the Windows Start menu.

• For Windows 2000, select Settings > Printers.
• For Windows XP/2003, select Printers and Faxes.
• For Windows Vista, select Control Panel > Hardware and Sound > 

Printers.
3. Select the your machine’s driver and right-click to open Properties. 

• For PS driver, select PS driver and right-click to open Properties.
4. In printer driver properties, select Device Options. 

• For PS driver, select Device Settings. 
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5. In printer driver properties, set the necessary options.
• For PS driver, select the Installable Options section and set the 

necessary options.
6. Click OK. 

UPGRADING A MEMORY MODULE
Your machine has a dual in-line memory module (DIMM). Use this memory 
module slot to install additional memory.
The machine has two memory slots with a factory pre-installed memory 
module in one slot. When you are expanding the memory capacity, you can 
add a memory module to the vacant memory slot. It is strongly 
recommended that you expand a memory module in the vacant memory 
slot, and not by removing a pre-installed memory module. If your machine 
has 64 MB memory capacity and you want to add 128 MB, the memory 
capacity expands up to 192 MB. Order information is provided for additional 
memory module. (See "Available accessories" on page 77.)

Installing a memory module
1. Turn the machine off and unplug all cables from the machine.
2. Grasp the control board cover and remove it.

3. Remove the new memory module from its bag. 
4. Holding the memory module by the edges, align the memory module on 

the slot at about a 30-degree tilt. Make sure that the notches of the 
module and the grooves on the slot fit each other.

 

The notches and grooves illustrated above may not match those 
on an actual memory module and its slot.

5. Press the memory module into the slot with care until you hear a ‘click’.

 

Do not press the memory module strongly or the module may be 
damaged. If the module does not seem to fit into the slot properly, 
carefully try the previous procedure again.

6. Replace the control board cover.

7. Reconnect the power cord and machine cable and turn the machine on.

 

If you use the PS driver, you must activate the added memory in the 
PS driver properties.
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12.specifications
This chapter guides you about this machine’s specifications such as various features.
This chapter include:
• General specifications
• Printer specifications
• Print media specifications
  

GENERAL SPECIFICATIONS

 

The symbol * optional feature depending on machines.

• Tray : 250 sheets for plain paper, 80 g/m2 (20 lb bond)
• Multi-purpose tray : 50 sheets for plain paper, 75 g/m2 (20 lb bond)
• Optional tray : 250 sheets for plain paper, 80 g/m2 (20 lb bond)

• Average operating mode : Less than 400 W
• Ready mode : Less than 60 W
• Power Save mode : Less than 8 W
• Power off mode : Less than 0.4 W

• Ready mode : 26 dB(A)
• Printing mode : 50 dB(A)

ITEM DESCRIPTION

Paper input capacity

( See "Print media specifications" on page 82.)

Paper output capacity Face down: 150 sheets 75 g/m2 (20 lb bond)

Power rating AC 110 - 127 V or AC 220 - 240 V
See the Rating label on the machine for the correct voltage, frequency (hertz) and type of current for your machine.

Power consumption

Noise Levela

Default time to power save mode 
from ready mode

15 Minutes

Boot-up timeb Less than 20 seconds

Operating environment Temperature: 10 to 32 °C (50 to 90 °F)
Humidity: 20 to 80% RH

Display 16 characters x 2 lines

Toner cartridge lifec 2,000 pagesd (shipped with the machine) 

Memory (Expendable)* 64 MB (max.192 MB) 
Use only the Samsung-approved DIMM.

External dimension
(W x D x H)

480 x 582 x 344 mm 
(18.90 x 22.91 x 13.54 inches) without optional tray

Weight
(Including consumables)

9.7 Kg (21.38 lbs)

Package weight Paper: 1.46 Kg (3.22lbs)
Plastic: 0.36 Kg (0.80lbs)

Duty cycle Up to 50,000 pages (Monthly)

Fusing temperature 180 °C (356 °F)
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PRINTER SPECIFICATIONS

a.Sound Pressure Level, ISO 7779. Configuration tested: machine basic installation, A4 paper, simplex printing.
b.Boot-up time is the time that takes from the power switch on to the ready mode.
c. Declared yield value in accordance with ISO/IEC 19752. The number of pages may be affected by operating environment, printing interval, media type, and 

media size.
d. It varies depending on the product configuration.

ITEM DESCRIPTION

Printing method Laser beam printing

Printing speeda

a.It will be affected by operating system used, computing performance, application software, connecting method, media type, media size and job complexity.

Up to 28 ppm (A4), 30 ppm (Letter)

Duplex printing speed Up to 14 ipm (A4), 14 ipm (Letter)

First print out time 8.5 seconds (from ready)

Print resolution Up to 1,200 x 1,200 dpi effective output

Printer language PostScript 3, PCL6, IBM ProPrinter, EPSON, SPL

OS compatibilityb

b.Visit www.samsungprinter.com to download the latest software version.

• Windows: 2000/XP/2003/Vista
• Various Linux OS ( See "Linux" on page 26.)
• Macintosh: Mac OS 8.6~9.2, Mac OS X 10.1~10.5

Interface • High speed USB 2.0
• Ethernet 10/100 Base TX (embedded type)

http://www.samsungprinter.com
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PRINT MEDIA SPECIFICATIONS 

TYPE SIZE DIMENSIONS
PRINT MEDIA WEIGHTa/CAPACITYb

a.If media weight is over 105 g/m2 (28 lb bond), load a paper into the tray one by one.
b.Maximum capacity may differ depending on media weight, thickness, and environmental conditions. 

TRAY1 / OPTIONAL TRAY MULTIPURPOSE TRAY

Plain paper Letter 216 x 279 mm (8.5 x 11 inches) 60 to 90 g/m2 (16 to 24 lb bond) 
• 250 sheets of 80g/m2(20 lb bond)

60 to 163 g/m2 (16 to 43 lb bond) 
• 50 sheets of 75 g/m2(20 lb 

bond)
Legal 216 x 356 mm (8.5 x 14 inches)

US Folio 216 x 330 mm (8.5 x 13 inches)

A4 210 x 297 mm (8.26 x 11.69 inches)

Oficio 216 x 343 mm (8.5 x 13.5 inches)

JIS B5 182 x 257 mm (7.16 x 10.11 inches) 60 to 90 g/m2 (16 to 24 lb bond) 
• 150 sheets of 80 g/m2(20 lb 

bond)
ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

Executive 184 x 267 mm (7.25 x 10.5 inches)

A5 148 x 210 mm (5.82 x 8.26 inches)

Statement 140 x 216 mm (5.5 x 8.5 inches) Not available in tray1/optional tray.

A6 105 x 148 mm (4.13 x 5.82 inches)

Envelope Envelope Monarch 98 x 191 mm (3.87 x 7.5 inches) 75 to 90 g/m2 (20 to 24 lb bond)
• 5 sheets stackingEnvelope No. 10 105 x 241 mm (4.12 x 9.5 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.37 x 9.01 inches)

Envelope C6 114 x 162 mm (4.48 x 6.38 inches)

Thick paper Refer to the Plain 
paper section 

Refer to the Plain paper section 90 to 105 g/m2 (24 to 28 lb bond)
• 20 sheets stacking

Thin paper Refer to the Plain 
paper section 

Refer to the Plain paper section 60 to 70 g/m2 (16 to 19 lb bond)
• 250 sheets stacking

60 to 70 g/m2 (16 to 19 lb bond)
• 250 sheets stacking

Transparency Refer to the Plain 
paper section 

Refer to the Plain paper section 138 to 146 g/m2 (36.81 to 38.91 
lb bond)
• 1 sheets stacking

Labelsc

c. Smoothness: 100 to 250 (sheffield)

Letter, Legal, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5, 
Statement

Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lb 
bond)
• 5 sheets stacking

Card stock Letter, Legal, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5, 
Statement

Refer to the Plain paper section 105 to 163 g/m2 ( 28 to 43lb 
bond)
• 5 sheets stacking

Minimum size (custom) 76 x 127 mm (2.99 x 5 inches) 60 to 163 g/m2 (16 to 43 lb bond) 

Maximum size (custom) 216 x 356 mm (8.5 x 14 inches)
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contact samsung worldwide
If you have any comments or questions regarding Samsung products, contact the Samsung customer care center.

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE

ARGENTINE 0800-333-3733 www.samsung.com/ar

AUSTRALIA 1300 362 603 www.samsung.com/au

AUSTRIA 0810-SAMSUNG (7267864, 
€ 0.07/min)

www.samsung.com/at

BELGIUM 02 201 2418 www.samsung.com/be 
(Dutch)
www.samsung.com/be_fr 
(French)

BRAZIL 0800-124-421
4004-0000

www.samsung.com/br

CANADA 1-800-SAMSUNG 
(726-7864)

www.samsung.com/ca

CHILE 800-SAMSUNG (726-7864) www.samsung.com/cl

CHINA 800-810-5858
400-810-5858
010-6475 1880

www.samsung.com/cn

COLOMBIA 01-8000112112 www.samsung.com.co

COSTA RICA 0-800-507-7267 www.samsung.com/latin

CZECH 
REPUBLIC

800-SAMSUNG 
(800-726786)

www.samsung.com/cz

Samsung Zrt., česká organizační složka, Oasis Florenc, 
Sokolovská394/17, 180 00, Praha 8

DENMARK 8-SAMSUNG (7267864) www.samsung.com/dk

ECUADOR 1-800-10-7267 www.samsung.com/latin

EL SALVADOR 800-6225 www.samsung.com/latin

ESTONIA 800-7267 www.samsung.com/ee

KAZAKHSTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

KYRGYZSTAN 00-800-500-55-500

FINLAND 30-6227 515 www.samsung.com/fi

FRANCE 3260 dites ‘SAMSUNG’ (€ 
0,15/min)
0 825 08 65 65 (€ 0,15/min)

www.samsung.com/fr

GERMANY 01805 - SAMSUNG 
(726-7864 € 0,14/min)

www.samsung.de

GUATEMALA 1-800-299-0013 www.samsung.com/latin

HONDURAS 800-7919267 www.samsung.com/latin

HONG KONG 3698-4698 www.samsung.com/hk

HUNGARY 06-80-SAMSUNG 
(726-7864)

www.samsung.com/hu

INDIA 3030 8282
1800 110011
1800 3000 8282 

www.samsung.com/in

INDONESIA 0800-112-8888 www.samsung.com/id

ITALIA 800-SAMSUNG(726-7864) www.samsung.com/it

JAMAICA 1-800-234-7267 www.samsung.com/latin

JAPAN 0120-327-527 www.samsung.com/jp

LATVIA 8000-7267 www.samsung.com/lv

LITHUANIA 8-800-77777 www.samsung.com/lt

LUXEMBURG 02 261 03 710 www.samsung.com/lu

MALAYSIA 1800-88-9999 www.samsung.com/my

MEXICO 01-800-SAMSUNG 
(726-7864)

www.samsung.com/mx

NETHERLANDS 0900-SAMSUNG 
(0900-7267864) (€ 
0,10/min)

www.samsung.com/nl

NEW ZEALAND  0800 SAMSUNG (0800 726 
786)

www.samsung.com/nz

NICARAGUA 00-1800-5077267 www.samsung.com/latin

NORWAY 3-SAMSUNG (7267864) www.samsung.com/no

PANAMA 800-7267 www.samsung.com/latin

PHILIPPINES 1800-10-SAMSUNG 
(726-7864)
1-800-3-SAMSUNG 
(726-7864)
02-5805777

www.samsung.com/ph

POLAND 0 801 1SAMSUNG 
(172678) 
022-607-93-33

www.samsung.com/pl

PORTUGAL 80820-SAMSUNG 
(726-7864)

www.samsung.com/pt

PUERTO RICO 1-800-682-3180 www.samsung.com/latin

REP. DOMINICA 1-800-751-2676 www.samsung.com/latin

EIRE 0818 717 100 www.samsung.com/ie

RUSSIA 8-800-555-55-55 www.samsung.ru

SINGAPORE 1800-SAMSUNG 
(726-7864)

www.samsung.com/sg

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE

http://www.samsung.com/ar
http://www.samsung.com.co
http://www.samsung.com/at
http://www.samsung.com/be
http://www.samsung.com/br
http://www.samsung.com/ca
http://www.samsung.com/cl
http://www.samsung.com/kz_ru
http://www.samsung.com/au
http://www.samsung.com/latin
http://www.samsung.com/cz
http://www.samsung.com/dk
http://www.samsung.com/latin
http://www.samsung.com/latin
http://www.samsung.com/latin
www.samsung.com/ee
http://www.samsung.com/cn
http://www.samsung.com/fi
http://www.samsung.com/fr
http://www.samsung.de
http://www.samsung.com/latin
http://www.samsung.com/hk
http://www.samsung.com/hu
http://www.samsung.com/in
http://www.samsung.com/id
http://www.samsung.com/it
http://www.samsung.com/latin
http://www.samsung.com/jp
http://www.samsung.com/lv
http://www.samsung.com/lt
http://www.samsung.com/lu
http://www.samsung.com/my
http://www.samsung.com/mx
http://www.samsung.com/nl
http://www.samsung.com/nz
http://www.samsung.com/no
http://www.samsung.com/latin
http://www.samsung.com/ph
http://www.samsung.com/pl
http://www.samsung.com/pt
http://www.samsung.com/latin
http://www.samsung.com/latin
www.samsung.com/ie
http://www.samsung.ru
http://www.samsung.com/sg
http://www.samsung.com
http://www.samsung.com/latin
http://www.samsung.com/latin
http://www.samsung.com/be_fr
http://www.samsung.com/be
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SLOVAKIA 0800-SAMSUNG 
(726-7864)

www.samsung.com/sk

SOUTH AFRICA 0860 SAMSUNG 
(726-7864)

www.samsung.com/za

SPAIN 902-1-SAMSUNG(902 172 
678)

www.samsung.com/es

SWEDEN 075-SAMSUNG (726 78 64) www.samsung.com/se

SWITZERLAND 0848-SAMSUNG (7267864, 
CHF 0.08/min)

www.samsung.com/ch

TADJIKISTAN 8-10-800-500-55-500

TAIWAN 0800-329-999 www.samsung.com/tw

THAILAND 1800-29-3232
02-689-3232

www.samsung.com/th

TRINIDAD & 
TOBAGO

1-800-SAMSUNG 
(726-7864)

www.samsung.com/latin

TURKEY 444 77 11 www.samsung.com/tr

U.A.E 800-SAMSUNG (726-7864)
8000-4726

www.samsung.com/ae

U.K 0845 SAMSUNG 
(726-7864)

www.samsung.com/uk

U.S.A 1-800-SAMSUNG 
(7267864)

www.samsung.com/us

UKRAINE 8-800-502-0000 www.samsung.ua

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

VENEZUELA 0-800-100-5303 www.samsung.com/latin

VIETNAM 1 800 588 889 www.samsung.com/vn

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE

http://www.samsung.com/sk
http://www.samsung.com/za
http://www.samsung.com/es
http://www.samsung.com/se
http://www.samsung.com/ch
http://www.samsung.com/tw
http://www.samsung.com/th
http://www.samsung.com/latin
http://www.samsung.com/tr
http://www.samsung.com/ae
http://www.samsung.com/uk
http://www.samsung.com/us
http://www.samsung.ua
http://www.samsung.com/kz_ru 
http://www.samsung.com/latin
http://www.samsung.com
http://www.samsung.com/vn
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glossary
 

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well 
as mentioned in this user’s guide.

802.11
802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards 
Committee (IEEE 802). 

802.11b/g
802.11b/g can share same hardware and use the 2.4 GHz band. 
802.11b supports bandwidth up to 11 Mbps; 802.11g up to 54 Mbps. 
802.11b/g devices may occasionally suffer interference from microwave 
ovens, cordless telephones, and Bluetooth devices. 

Access point
Access Point or Wireless Access Point (AP or WAP) is a device that 
connects wireless communication devices together on wireless local 
area networks (WLAN), and acts as a central transmitter and receiver of 
WLAN radio signals. 

ADF
An Automatic Document Feeder (ADF) is a mechanism that will 
automatically feed an original sheet of paper so that the machine can 
scan some amount of the paper at once. 

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Macintosh (1984) 
and is now deprecated by Apple in favor of TCP/IP networking.

BIT Depth
A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher color 
depth gives a broader range of distinct colors. As the number of bits 
increases, the number of possible colors becomes impractically large for 
a color map. 1-bit color is commonly called as monochrome or black and 
white.

BMP
A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file 
format on that platform.

BOOTP
Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the bootstrap 
process of computers or operating systems running on them. The 
BOOTP servers assign the IP address from a pool of addresses to each 
client. BOOTP enables 'diskless workstation' computers to obtain an IP 
address prior to loading any advanced operating system.

CCD
Charge Coupled Device (CCD) is a hardware which enables the scan 
job. CCD Locking mechanism is also used to hold the CCD module to 
prevent any damage when you move the machine.

Collation
Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel
A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in front of 
the machine. 

Coverage
It is the printing term used for a toner usage measurement on printing. 
For example, 5% coverage means that an A4 sided paper has about 5% 
image or text on it. So, if the paper or original has complicated images or 
lots of text on it, the coverage will be higher and at the same time, a 
toner usage will be as much as the coverage.

CSV
Comma Separated Values (CSV). A type of file format, CSV is used to 
exchange data between disparate applications. The file format, as it is 
used in Microsoft Excel, has become a pseudo standard throughout the 
industry, even among non-Microsoft platforms.

DADF
A Duplex Automatic Document Feeder (DADF) is a mechanism that will 
automatically feed and flip over an original sheet of paper so that the 
machine can scan on both sides of the paper.

Default
The value or setting that is in effect when taking a printer out of its box 
state, reset, or initialized.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration parameters 
specific to the DHCP client host requesting, generally, information 
required by the client host to participate on an IP network. DHCP also 
provides a mechanism for allocation of IP addresses to client hosts.

DIMM
Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the machine like printing data, 
received fax data.
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DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on networks, 
such as the Internet.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print head 
that runs back and forth on the page and prints by impact, striking an 
ink-soaked cloth ribbon against the paper, much like a typewriter.

DPI
Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD 
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone line to 
answer several different telephone numbers.

Duplex
A mechanism that will automatically flip over a sheet of paper so that the 
machine can print (or scan) on both sides of the paper. A printer 
equipped with a Duplex can print double-sided of paper.

Duty Cycle
Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan limitation 
such as pages per year. The lifespan means the average capacity of 
print-outs, usually within the warranty period. For example, if the duty 
cycle is 48,000 pages per month assuming 20 working days, a printer 
limits 2,400 pages a day.

ECM
Error Correction Mode (ECM) is an optional transmission mode built into 
Class 1 fax machines or fax modems. It automatically detects and 
corrects errors in the fax transmission process that are sometimes 
caused by telephone line noise.

Emulation
Emulation is a technique of one machine obtaining the same results as 
another.
An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 
Emulation focuses on exact reproduction of external behavior, which is 
in contrast to simulation, which concerns an abstract model of the 
system being simulated, often considering its internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the physical 
layer, and frame formats and protocols for the media access control 
(MAC)/data link layer of the OSI model. Ethernet is mostly standardized 
as IEEE 802.3. It has become the most widespread LAN technology in 
use during the 1990s to the present.

EtherTalk
A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original Macintosh (1984) and is now 
deprecated by Apple in favor of TCP/IP networking. 

FDI
Foreign Device Interface (FDI) is a card installed inside the machine to 
allow a third party device such as a coin operated device or a card 
reader. Those devices allow the pay-for-print service on your machine.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).

Fuser Unit 
The part of a laser printer that melts the toner onto the print media. It 
consists of a hot roller and a back-up roller. After toner is transferred 
onto the paper, the fuser unit applies heat and pressure to ensure that 
the toner stays on the paper permanently, which is why paper is warm 
when it comes out of a laser printer.

Gateway
A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer or a 
network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are represented 
by various shades of gray.

Halftone
An image type that simulates grayscale by varying the number of dots. 
Highly colored areas consist of a large number of dots, while lighter 
areas consist of a smaller number of dots.

HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or hard 
disk, is a non-volatile storage device which stores digitally-encoded data 
on rapidly rotating platters with magnetic surfaces.

IEEE
The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the advancement 
of technology related to electricity.

IEEE 1284
The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers to 
a specific connector type on the end of the parallel cable that attaches to 
the peripheral (for example, a printer). 
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Intranet
A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of 
an organization's information or operations with its employees. 
Sometimes the term refers only to the most visible service, the internal 
website.

IP address
An Internet Protocol (IP) address is a unique number that devices use in 
order to identify and communicate with each other on a network utilizing 
the Internet Protocol standard.

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a printer 
can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and so 
forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing solution 
than older ones.

IPX/SPX
IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives from 
national standards bodies. It produces world-wide industrial and 
commercial standards.

ITU-T
The International Telecommunication Union is an international 
organization established to standardize and regulate international radio 
and telecommunications. Its main tasks include standardization, 
allocation of the radio spectrum, and organizing interconnection 
arrangements between different countries to allow international phone 
calls. A -T out of ITU-T indicates telecommunication.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG
Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 

compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It is the 
format used for storing and transmitting photographs on the World Wide 
Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over 
TCP/IP.

LED
A Light-Emitting Diode (LED) is a semiconductor device that indicates 
the status of a machine.  

MAC address
Media Access Control (MAC) address is a unique identifier associated 
with a network adapter. MAC address is a unique 48-bit identifier usually 
written as 12 hexadecimal characters grouped in pairs (e. g., 
00-00-0c-34-11-4e). This address is usually hard-coded into a Network 
Interface Card (NIC) by its manufacturer, and used as an aid for routers 
trying to locate machines on large networks.

MFP
Multi Function Peripheral (MFP) is an office machine that includes the 
following functionality in one physical body, so as to have a printer, a 
copier, a fax, a scanner and etc.

MH
Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax machines 
to transfer the image recommended by ITU-T T.4. MH is a 
codebook-based run-length encoding scheme optimized to efficiently 
compress white space. As most faxes consist mostly of white space, this 
minimizes the transmission time of most faxes. 

MMR
Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.

Modem
A device that modulates a carrier signal to encode digital information, 
and also demodulates such a carrier signal to decode transmitted 
information.

MR
Modified Read (MR) is a compression method recommended by ITU-T 
T.4. MR encodes the first scanned line using MH. The next line is 
compared to the first, the differences determined, and then the 
differences are encoded and transmitted.



Glossary_ 88

NetWare
A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the 
network protocols were based on the archetypal Xerox XNS stack. 
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a virtual 
image for print using a laser beam emitted from a laser printer, and it is 
usually green or gray colored and a cylinder shaped. 
An exposing unit of a drum is slowly worn away by its usage of the 
printer, and it should be replaced appropriately since it gets scratches 
from grits of a paper.

Originals
The first example of something, such as a document, photograph or text, 
etc, which is copied, reproduced or translated to produce others, but 
which is not itself copied or derived from something else.

OSI
Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for communications. 
OSI offers a standard, modular approach to network design that divides 
the required set of complex functions into manageable, self-contained, 
functional layers. The layers are, from top to bottom, Application, 
Presentation, Session, Transport, Network, Data Link and Physical.

PABX 
A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL has 
been released in varying levels for thermal, matrix printer, and page 
printers.

PDF
Portable Document Format (PDF) is a proprietary file format developed 
by Adobe Systems for representing two dimensional documents in a 
device independent and resolution independent format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing areas. - 
that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the computer 
to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which can 
be used on a printer, a scanner, a fax or, a copier.

PPM
Pages Per Minute (PPM) is a method of measurement for determining 
how fast a printer works, meaning the number of pages a printer can 
produce in one minute.

PRN file
An interface for a device driver, this allows software to interact with the 
device driver using standard input/output system calls, which simplifies 
many tasks. 

Protocol
A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS
See PostScript.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of the 
world's public circuit-switched telephone networks which, on industrial 
premises, is usually routed through the switchboard.

RADIUS
Remote Authentication Dial In User Service (RADIUS) is a protocol for 
remote user authentication and accounting. RADIUS enables 
centralized management of authentication data such as usernames and 
passwords using an AAA (authentication, authorization, and accounting) 
concept to manage network access.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB
Server Message Block (SMB) is a network protocol mainly applied to 
share files, printers, serial ports, and miscellaneous communications 
between nodes on a network. It also provides an authenticated 
Inter-process communication mechanism.

SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, 
text-based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a client-server 
protocol, where the client transmits an email message to the server.

SSID
Service Set Identifier (SSID) is a name of a wireless local area network 
(WLAN). All wireless devices in a WLAN use the same SSID in order to 
communicate with each other. The SSIDs are case-sensitive and have a 
maximum length of 32 characters.
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Subnet Mask 
The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and which 
part is the host address.

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol (IP); 
the set of communications protocols that implement the protocol stack 
on which the Internet and most commercial networks run.

TCR
Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible and 
platform-independent format can be used for pictures that have been 
made by various image processing applications.

Toner Cartridge
A kind of bottle within a machine like printer which contains toner. Toner 
is a powder used in laser printers and photocopiers, which forms the text 
and images on the printed paper. Toner can be melted by the heat of the 
fuser, causing it to bind to the fibers in the paper.

TWAIN
An industry standard for scanners and software. By using a 
TWAIN-compliant scanner with a TWAIN-compliant program, a scan can 
be initiated from within the program.; an image capture API for Microsoft 
Windows and Apple Macintosh operating systems.

UNC Path
Uniform Naming Convention (UNC) is a standard way to access network 
shares in Window NT and other Microsoft products. The format of a 
UNC path is: \\<servername>\<sharename>\<Additional directory>

URL
Uniform Resource Locator (URL) is the global address of documents 
and resources on the Internet. The first part of the address indicates 
what protocol to use, the second part specifies the IP address or the 
domain name where the resource is located.

USB
Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and peripherals. 
Unlike the parallel port, USB is designed to concurrently connect a 
single computer USB port to multiple peripherals.

Watermark
A watermark is a recognizable image or pattern in paper that appears 
lighter when viewed by transmitted light. Watermarks were first 
introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.

WEP
Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 
802.11 to provide the same level of security as that of a wired LAN. WEP 
provides security by encrypting data over radio so that it is protected as 
it is transmitted from one end point to another.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that is 
originally introduced in Windows Me and Windows XP. A scan can be 
initiated from within these operating systems by using a WIA-compliant 
scanner.

WPA
Wi-Fi Protected Access (WPA) is a class of systems to secure wireless 
(Wi-Fi) computer networks, which was created to improve upon the 
security features of WEP.

WPA-PSK
WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small 
business or home users. A shared key, or password, is configured in the 
wireless access point (WAP) and any wireless laptop or desktop 
devices. WPA-PSK generates a unique key for each session between a 
wireless client and the associated WAP for more advanced security.
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